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The En-ROADS Climate Solutions Simulator is a fast, powerful climate simulation tool for understanding how we
can achieve our climate goals through changes in energy, land use, consumption, agriculture, and other policies.
The simulator focuses on how changes in global GDP, energy efficiency, technological innovation, and carbon price
influence carbon emissions, global temperature, and other factors. It is designed to provide a synthesis of the best
available science on climate solutions and put it at the fingertips of groups in policy workshops and roleplaying games.
These experiences enable people to explore the long-term climate impacts of global policy and investment decisions.
En-ROADS is being developed by Climate Interactive, Ventana Systems, UML Climate Change Initiative, and MIT
Sloan.
This guide provides background on the dynamics of En-ROADS, tips for using the simulator, general descriptions,
real-world examples, slider settings, and model structure notes for the different sliders in En-ROADS.
In addition to this User Guide, there is an extensive Reference Guide that covers model assumptions and structure, as
well as references for data sources.
Please visit support.climateinteractive.org for additional inquires and support.
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1.1 About En-ROADS
En-ROADS is a powerful simulation model for exploring how to address global energy and climate challenges through
large-scale policy, technological, and societal shifts. With En-ROADS you can create scenarios that focus on how
changes in taxes, subsidies, economic growth, energy efficiency, technological innovation, carbon pricing, fuel mix,
and other factors will change global carbon emissions and temperature.
En-ROADS is designed to be used interactively with groups where it can be the basis for scientifically rigorous conversations around addressing climate change. This makes it ideal for decision-makers in government, business, and civil
society; or for anyone who is curious about the choices of our world. Climate Interactive provides extensive materials
to support people in leading activities with En-ROADS that range from policy workshops to roleplaying games.
Relative to many global energy and climate system models, En-ROADS returns results in a few seconds, is transparent
in its mathematical logic, and allows you to interactively test hundreds of factors. En-ROADS complements the
other, more disaggregated models addressing similar questions, for example, those in the EMF-22 suite. These larger
disaggregated models are used for data and calibrating results in En-ROADS.
En-ROADS stands for “Energy-Rapid Overview and Decision-Support.” Led by the team at Climate Interactive, EnROADS has benefited from a close collaboration between Climate Interactive, Tom Fiddaman of Ventana Systems,
Prof. John Sterman of MIT Sloan, and Prof. Juliette Rooney-Varga of UMass Lowell’s Climate Change Initiative. EnROADS is an extension of the award-winning simulator C-ROADS, which thousands have used to assess national and
regional greenhouse gas emission reduction pledges and lead climate negotiation exercises. Both tools were developed
using the system dynamics modeling approach and draw on the MIT PhD theses of Dr. John Sterman and Dr. Tom
Fiddaman.
The model emphasizes the system-wide interactions of policies. Behind the simulation is an extensive study of the
latest research literature on factors such as delay times, progress ratios, price sensitivities, historic growth of energy
sources, and energy efficiency potential. This enables En-ROADS to reveal the dynamic interactions between different
levers, such as how energy efficiency affects renewable energy, and which feedback loops are most significant.
For those familiar with C-ROADS, the distinction between the two is that C-ROADS focuses on how changes in
national and regional emissions could affect global carbon emissions and climate outcomes, while En-ROADS focuses
on how global changes in energy, economics, and public policy could affect global carbon emissions and climate
outcomes.
Please visit support.climateinteractive.org for additional inquires and support.
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1.2 En-ROADS Tutorial
En-ROADS is designed to be easy to use. You can watch this 20-minute introductory video tour of En-ROADS. We
encourage you to explore all the features of En-ROADS by clicking around. Here are some key features of En-ROADS:

1.2.1 Graphs
There are almost 100 output graphs available in En-ROADS. They show data from different parts of the global energy
and climate system, and update as you move sliders within En-ROADS.
A. Select graphs – When you first open En-ROADS, you see the two default graphs. You can select from the full
list of graphs by clicking the title of the left or right graph. You can also select from the Graphs menu from the
top toolbar.
B. More info – For more information about a graph and what it shows, select the triangle icon to the left of the
graph title.
C. Copy graph data – Copy the graph data to your clipboard using the copy icon on the top right side of a graph.
D. Shortcut to popular graphs – You can quickly jump to a selection of the most commonly used graphs from the
“Show miniature graphs” icon on the top toolbar. You can click any of these miniature graphs to switch to that
graph in the main graph view.
E. View larger graphs – If you want to expand one of the graphs into a separate window, you can access our
“Large Left Graph” or “Large Right Graph” feature from the View menu in the top toolbar.

1.2.2 Sliders/Actions
There are 18 sliders representing different actions you can test in the En-ROADS simulator. Click the title of the slider
or the three dots on the right of each slider to access detailed slider settings:

Here is what you will find in the detailed slider view:
A. A description of the overall slider - This description provides further detail about the particular solution.
B. More control of the main slider - You’ll see the units associated with the slider and the numeric values of
points along the slider. You can directly input numeric values to set the slider level to a specific value of your
choice (within range). Scroll down to change and explore the related sliders. Click on the triangle to the left of
each slider title to see a brief description of the slider.
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C. Related graphs - In the right panel, you’ll see a graph relevant to the main slider as well as a choice of additional
Related Graphs. These are useful to reference in order to examine the changes that occur from moving the sliders
in this view. Select from the dropdown list of Related Graphs to view other graphs. You will still be able to see
your slider moves impact the main graphs as well.
D. Help - You can access more detailed information about the slider through the information button. This is the
same information that is found for this topic in the En-ROADS User Guide.

1.2.3 Top Toolbar Features
Many useful features are just a click away from the top toolbar on En-ROADS. Here are some of the features that you
can access.

A. Share Your Scenario – You can share your unique scenario link to others. Others can open your En-ROADS
scenario with all the settings you have chosen and the last main graphs you viewed. You can then share your
scenario to social media channels. Grabbing the link from your browser’s URL bar will also work, however,
your last viewed graphs will not be captured.
B. Replay Last Change – This is a fun feature to rapidly replay your last change several times. This feature assists
you in examining how the different parts of the system responded to your action by giving you more time to
look for changes across related graphs. You can also use the other controls to Undo or Redo your last action
(located left of the “replay last change” control on the top toolbar).
C. Assumptions [under the “Simulation” menu] – Access and change important assumptions driving the EnROADS model.
D. U.S. Units [under the “View” menu] – Change from metric to U.S. units.
E. Actions and Outcomes [under the “View” menu] – This list summarizes the total actions and key climate
outcomes from your scenario.
F. Related Examples [under the “Help” menu] – This list shares common examples of topics and solutions related
to each of the 18 sliders. This is helpful when you need to quickly pull up a list of examples which relate to each
of the sliders.
Please visit support.climateinteractive.org for additional inquires and support.

1.2. En-ROADS Tutorial
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1.3 En-ROADS Structure
A simple way to think about the structure of En-ROADS is by considering the drivers of climate impacts. In the
simulator, the concentration of greenhouse gases drives up global temperature, which leads to various impacts (e.g.,
sea level rise and ocean acidification).

The concentration of greenhouse gases in the atmosphere is driven by four main sources:
1. Energy CO2 Emissions from burning coal, oil, gas, and biomass. CO2 emissions from energy currently comprise about 65% of greenhouse gas emissions.
2. Land Use CO2 Emissions such as forestry and land use change. CO2 emissions from land use currently
comprise about 7% of greenhouse gas emissions.
3. Carbon Dioxide Removal approaches that pull carbon dioxide out of the atmosphere and store it in plants,
soils, or underground leading to a decrease in CO2 concentrations.
4. Other Greenhouse Gas Emissions such as methane, N2 O, and F-gases. Non-CO2 emissions currently comprise
about 28% of total greenhouse gas emissions.

Going further, CO2 emissions from energy are driven by four factors, which is known as the “Kaya Identity”. Population, consumption (GDP/capita), energy intensity (energy use per dollar of GDP), and carbon intensity (CO2 emissions
per unit of energy) are all multiplied together and the result is overall energy CO2 emissions. In this way, at a high level,
reducing CO2 emissions is about four things: fewer people, less consumption, more efficiency, and less high-carbon
energy supplies.

6
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1.4 Kaya Graphs
This view shows the drivers of growth in carbon dioxide emissions from energy, which reflects about two-thirds of all
greenhouse gas emissions.
It is called the “Kaya” view because of the equation below, created by Yoichi Kaya:
Global Population x GDP per Capita x Energy Intensity of GDP x Carbon Intensity of Energy = CO2 Emissions from
Energy
Here is one way to understand its trends over time:
Global Population is growing—we are currently approaching 8 billion people—and anticipate growth to 11 billion
by the end of the century, according to UN projections. The rate of growth is slowing over time as people have smaller
families.
GDP per Capita is growing steadily per year, and we assume it will continue, mostly as people in rapidly developing
countries such as China, India, South Africa, Mexico, Brazil, and Indonesia attain higher standards of living.
Energy Intensity of GDP is decreasing over time, due to the world economy becoming more efficient, or using less
energy per unit of economic output. Technologies are improving—for example, more efficient cars, buildings, and
machines—and economies are shifting from manufacturing to services. The product of global population, GDP per
capita, and the energy intensity of GDP is the total amount of energy used by the global economy.
Carbon Intensity of Final Energy, the amount of carbon dioxide emitted by energy use, is expected to slightly
decline over time. Overall, this downward trend in carbon intensity is attributed to the gradual shifting away from
fossil fuels and towards low-carbon energy sources.
Carbon Dioxide Emissions from Energy is the result of all four factors multiplied together, and you can see that in the
Baseline scenario emissions are growing. As the level of carbon dioxide in the atmosphere correlates with temperature,
an increased concentration of carbon dioxide in the atmosphere leads to an increase in global temperatures.
These factors explain in simple terms, why emissions are increasing in the Baseline scenario. Improvements in efficiency and decarbonization are not yet keeping up with the strong growth in population and consumption.

1.4. Kaya Graphs
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1.5 Background on En-ROADS Dynamics
As you use En-ROADS, pay attention to when and how much slider adjustments result in departures from the Baseline
scenario. Ask your audience to reflect on why this happened to illuminate thinking about the dynamics of the climate
and energy system that En-ROADS simulates.
Most of the dynamics in En-ROADS can be answered by these explanations:

1.5.1 1. Drivers of the Baseline Scenario
To gain a deeper understanding of the model’s behaviors, it is important to comprehend what factors drive the Baseline
scenario.
Drivers of Growth
A challenge to limiting future warming in this simulation is the powerful growth in global GDP, which is population
multiplied by GDP per person. Energy efficiency and changes to the fuel mix can help reduce energy emissions,
but their success is dampened by the steady growth in GDP. Recognizing this fact leads many participants to explore
different futures for population (for example, by empowering women in developing countries, which could lower
population growth) and economic growth measured in GDP per person (for example, by finding ways to meet economic
needs without increasing consumption).
This addresses questions such as:
• “We’ve done a lot in energy efficiency and clean energy – why haven’t emissions reduced substantially enough?”
To illustrate this point: See the Kaya Graphs view below for a low emissions scenario with increased energy efficiency
and a transition to low carbon energy sources. Even though Energy Intensity of GDP improves, and the Carbon
Intensity of Energy decreases as well, Global Population and GDP per person continue to grow.

Non-CO2 Emissions Affect Temperature Significantly
Methane, N2 O, and the F-gases are controlled by the Methane & Other slider. Adjusting this has a large impact on
temperature. This implies significant changes in livestock management and consumption, waste management, fertilizer
use, and industry. These emissions currently make up around 28% of total greenhouse gas emissions.
Addresses questions such as:
• “We’ve done a lot in energy – why haven’t we solved the climate crisis?”
To illustrate this point: See the “Greenhouse Gas Net Emissions by Gas – Area” and “Greenhouse Gas Net Emissions”
graphs and adjust the Methane & Other slider. See the scenario below – highly reducing Methane & Other emissions
achieves a significant reduction in 2100 temperature.
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1.5.2 1. Complex Interactions Between Competing Energy Supplies and Demand
Economies of Scale and Learning
Costs of energy supplies such as renewables fall as cumulative experience is gained through a learning feedback
loop, also known as “economies of scale.” Every doubling of cumulative installed capacity of renewables reduces
costs by around 20%, creating a reinforcing loop (this is known as the “progress ratio”). Increasing the capacity
(1) and installation (2) of new energy sources leads to increased learning (3), a decrease in price (4), increasing the
attractiveness of renewables (5) and therefore even greater capacity and installations:

This addresses questions such as:
• “Why should we have hope?”
• “How can we afford a transition to a low-carbon economy?”
• “Aren’t the costs of renewables prohibitive?”

1.5. Background on En-ROADS Dynamics
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To illustrate this point: Look at the “Renewables Primary Energy Demand” graph in a scenario in which Renewables
are subsidized. It sparks an initial exponential growth that is driven and sustained by the reinforcing learning loop
figure shown above.

Delays and Capital Stock Turnover
New energy sources (e.g., renewables and new zero-carbon energy sources) take decades (not years) to scale up
sufficiently to compete with coal, oil, and gas globally. One of the main sources of these delays is that new energy
infrastructure is only built when old infrastructure retires or there is a need to meet increased energy demand. Only
about 6% of all the world’s energy infrastructure changes each year, since infrastructure like coal-fired power plants
and oil refineries can be used for 30 or more years. So while new zero-carbon energy sources may make up the majority
of the market share of new energy capital, it will take many years for the old capital to turn over and be retired. The
climate is only helped when coal, oil, and gas is retired away, and in the absence of other interventions, that amount is
relatively small — approximately 3% per year.

This addresses questions such as:
• “Why doesn’t subsidizing renewables, nuclear, or a new zero-carbon energy source help avoid more warming?”
This dynamic is also relevant to increasing energy efficiency, however, energy-using capital such as vehicles, buildings,
and industry, has an average lifetime that is much shorter (10-15 years). One can promote increases to energy efficiency
of new cars immediately, for example, but the average energy efficiency of all the cars takes decades to improve since
it takes time for all the old inefficient cars to be taken off the road.
To illustrate this point: Move the New Zero-Carbon slider to huge breakthrough. Examine the “Global Sources of
Primary Energy” graph and notice that, even as low-carbon sources grow, it takes several decades before enough fossil
fuel capacity retires away to make much of an impact. Notice that coal, oil, and natural gas grow steadily through the
2020s and 2030s and it takes time for greenhouse gas emissions to depart from the Baseline scenario.
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Implications of this dynamic: Policies that merely promote alternatives to fossil fuels take several decades to reduce
carbon dioxide emissions — the existing infrastructure takes a long time to retire away. Thus, meeting climate goals
also requires direct disincentives to building and using fossil fuel infrastructure.
Price and Demand Effects
Energy demand falls if energy prices rise, and demand increases if prices fall. The first dynamic is evident when carbon
prices increase. The second dynamic occurs when zero-carbon energy such as renewables or a new zero-carbon energy
source are either subsidized or experience a breakthrough in cost improvement.
While subsidizing low-carbon energy supplies such as Renewables, watch Final Energy Consumption increase. Inexpensive wind and solar spreading around the world decreases overall energy prices and boosts energy demand up:

On the other hand, implementing a carbon price causes energy costs to increase and consumption to decrease:

Crowding Out or Squeezing the Balloon

1.5. Background on En-ROADS Dynamics
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Many assume that if the world promoted several long term zero-carbon energy sources such as nuclear, wind, and
solar, their contribution to carbon mitigation would be additive. Instead, they actually compete. More of one, less of
the other.
This addresses questions such as:
• “Why didn’t it help to have a breakthrough in a new zero-carbon energy supply in this renewable-dominated
scenario?”
To illustrate this point: See the “Global Sources of Primary Energy” graph in the three scenarios below. In the first
graph, we subsidize renewables alone; in the second, there is a breakthrough in a new zero-carbon energy supply; in
the third graph, we see both a renewables subsidy and a new zero-carbon breakthrough.
In the following scenario, a high Renewables subsidy leads to a 0.2 degree Celsius reduction in temperature:

A huge breakthrough in New Zero-Carbon also leads to a 0.2 degree Celsius reduction on its own:

When combined, instead of seeing an additive 0.4 degree Celsius reduction, we only see a 0.3 degree reduction in
temperature due to the energy supplies competing with each other for market share:
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1.5.3 3. System Dynamics of the Climate
Bathtub Dynamics - Temperature and CO2 Concentrations Seem Weakly Responsive to CO2 Emissions
Emissions must fall significantly just to change the growth in temperature and CO2 concentrations slightly. This
counterintuitive dynamic is an important feature of the carbon and climate system. A short explanation for this dynamic
would include the fact that the momentum in the carbon cycle and the climate lead to long delays between emissions
and temperature.
This addresses questions such as:
• “Emissions are stabilized, so why is temperature or CO2 concentration still going up?”
To illustrate this point: See the “CO2 Emissions and Removals” and “CO2 Concentration” graphs in a scenario where
CO2 emissions stabilize. Even though CO2 emissions (in red below) have flattened, CO2 concentrations (in blue on
the right below) continue to increase:

Similarly, in a much more stringent scenario where CO2 concentration stabilizes, temperature change continues to
increase:

To understand more about stocks, flows, and the bathtub framing below, check out our Climate Leader learning series.

1.5. Background on En-ROADS Dynamics
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Please visit support.climateinteractive.org for additional inquires and support.

1.6

Coal

Discourage or encourage mining coal and burning it in power plants. Coal is the most harmful fossil fuel in terms
of carbon emissions, as well as in air pollutants that cause severe health impacts. It is a dominant source of energy
globally, however, because it is relatively inexpensive to mine and transport.

1.6.1 Examples
• Government policies that phase out power plants or make them more expensive in any way, such as taxes on
coal.
• Financial services industry (e.g. banks) or global development institutions (e.g. World Bank) limiting access to
capital for new coal mining, refining, and power plant infrastructure.
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1.6.2 Big Messages
• Discouraging coal is a high leverage strategy for reducing future temperature change. It keeps coal in the ground,
increases the cost of energy, and reduces energy demand.
• Discouraging coal also improves public health and saves medical costs through improved air quality.

1.6.3 Key Dynamics
• When coal is discouraged, by taxing it, watch the brown area of Coal go down in the “Sources of Primary
Energy” graph. It is one of the most sensitive energy supplies to any increase in cost. Unlike oil, it can often be
substituted for natural gas and renewables.
• Taxing coal also reduces energy demand (see graphs “Final Energy Consumption” and “Cost of Energy”).
When energy prices are higher, people tend to use energy more efficiently and conserve energy. However,
tax policies must be implemented with considerations for poor and working-class communities who can be
harmfully impacted by high energy prices.

1.6.4 Potential Co-Benefits of Discouraging Coal
• Reduced air pollutants from coal burning improves air quality and health outcomes for surrounding communities.
• Less coal mining reduces heavy metal drainage and waste from mine sites which improves water quality and
helps protect wildlife habitats, biodiversity, and ecosystem services.

1.6.5 Equity Considerations
• Taxing coal can raise energy costs for households and businesses that rely on coal for energy needs.
• Low-income communities often suffer the worst health outcomes yet make up the majority of individuals who
produce coal. Providing pathways for these people to find new jobs will be essential.

1.6.6 Slider Settings
The following table highlights the numerical ranges for the labelled input levels of the Coal slider. Each of the energy
supply sliders is set to reflect a similar percentage cost increase or decrease for each input level.

Change in price per ton of coal equivalent (tce)
Cost increase or decrease

1.6. Coal

very highly
taxed
+$110 to +$40
+200%
+60%

to

highly
taxed
+$40
+$20
+60%
+30%

taxed
to
to

+$20
+$6
+30%
+10%

to
to

status
quo
+$6 to -$6

subsidized
-$6 to -$20

+10% to 10%

-10% to 30%
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1.6.7 Model Structure
The cost of coal affects three significant decisions regarding energy infrastructure:
1. Investment in new capacity (whether or not to build new processing and power plants);
2. use of capacity (whether to run existing plants);
3. retirement of capacity (whether to keep plants longer or shorter than the average of ~30 years).

1.6.8 Case Studies
United States: Replacing all coal-powered electricity in the US with solar power could save 52,000 lives per year,
which is more than the number of people employed by the coal industry today.1
United States: The total cost of reliance on coal to the US economy is estimated to be $344 billon per year. Of that cost,
$187B is from air pollution, $74.6B is from public health affects in Appalachia, and $61.7B from climate damages.2
India: A one gigawatt increase in coal-fired capacity corresponds to a nearly 15% increase in infant mortality in areas
close to coal power plants. The effect was largest for older plants, plants in areas with relatively higher pollution
levels, and plants burning domestic rather than imported coal.3

1.6.9 FAQs
How can I directly force deeper reductions in coal use? Consider selecting the “Stop building new coal infrastructure” switch in the advanced view, and changing the “% Reduction in coal utilization” slider.
Please visit support.climateinteractive.org for additional inquires and support.

1.7

Oil

Discourage or encourage drilling, refining, and consuming oil for energy. Oil is a fossil fuel that is used widely in
cars, ships, and planes; it is also used for industry, heating, and electricity. Access to oil has sparked major conflicts,
and oil spills threaten ecosystems and water quality.

1.7.1 Examples
• Governments imposing limits on oil drilling and exploration, removing subsidies, and taxing oil.
• Universities, corporations, and individuals divesting from oil companies.
• Financial services industry (e.g., banks) or global development institutions (e.g., World Bank) limiting access to
capital for exploration, drilling, refining, and delivery.
1 Prehoda, E. W., & Pearce, J. M. (2017). Potential lives saved by replacing coal with solar photovoltaic electricity production in the U.S.
Renewable and Sustainable Energy Reviews, 80, 710–715. http://dx.doi.org/10.1016/j.rser.2017.05.119
2 Epstein, P. R., Buonocore, J. J., Eckerle, K., Hendryx, M., Iii, B. M. S., Heinberg, R., . . . Glustrom, L. (2011). Full cost accounting for the life
cycle of coal. Annals of the New York Academy of Sciences, 1219(1), 73–98. https://doi.org/10.1111/j.1749-6632.2010.05890.x
3 Barrows, G., Garg, T., & Jha, A. (2019). The Health Costs of Coal-Fired Power Plants in India. SSRN. http://dx.doi.org/10.2139/ssrn.3281904
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1.7.2 Big Message
• When a steep oil tax is the only action implemented, you will not see a dramatic change in temperature, as coal
and natural gas demand increases in response, offsetting any large reduction of temperature.

1.7.3 Key Dynamics
• When oil is discouraged, by taxing it, watch the red area of Oil go down in the “Global Sources of Primary
Energy” graph.
• When oil is taxed, notice what happens to coal and gas in response. Unless there are restrictions on coal and
gas, their demand will go up in response to expensive oil. We call this the “squeeze the balloon” problem –
depressing fossil fuel emissions in one area causes them to pop up in another. Renewables are also boosted
slightly, but the impact is negligible. Adding a carbon price is a good solution to the “squeeze the balloon”
problem, as it addresses all fossil fuels together.
• Notice that taxing oil results in an increase in electrification of the vehicle fleet as electric powered modes of
transport become more affordable in the face of higher oil prices. See this demonstrated in the “Electric Share
of Final Energy-Transport” graph.

1.7.4 Potential Co-Benefits of Discouraging Oil
• A reduction in oil drilling could lead to fewer oil spills, helping protect wildlife habitats, biodiversity, and
ecosystem services at production sites and along transportation routes.
• Reduced economic dependence on oil can improve national security and lower military costs.

1.7.5 Equity Considerations
• The oil industry provides many high-paying jobs for people with technical trade backgrounds. Providing pathways for these people to find new jobs will be essential.
• Oil companies wield enormous economic and political power locally and globally. In order to discourage oil,
certain industry protections must be eliminated.
• There is a history of oil refineries being located in marginalized communities and companies working to avoid
or limit environmental regulations.

1.7.6 Slider Settings
The following table highlights the numerical ranges for the labelled input levels of the Oil slider. Each of the energy
supply sliders is set to reflect a similar percentage cost increase or decrease for each input level.

Change in price per barrel of oil
equivalent (boe)
Cost increase or decrease

1.7. Oil

very highly
taxed
+$100
to
+$30
+200%
to
+60%

highly
taxed
+$30
+$15
+60%
+30%

taxed
to
to

+$15
+$5
+30%
+10%

status quo
to

+$5 to -$5

subsidized
-$5 to -$15

to

+10% to 10%

-10% to 30%
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1.7.7 Model Structure
The cost of oil affects three significant decisions regarding energy infrastructure:
1. Investment in new capacity (whether or not to build new drilling operations and refineries);
2. use of capacity (whether to run existing operations);
3. retirement of capacity (whether to keep infrastructure longer or shorter than the average of ~30 years).

1.7.8 FAQs
How can I directly force deeper reductions in oil use? Consider selecting the “Stop building new oil infrastructure”
switch in the advanced view, and changing the “% Reduction in oil utilization” slider.
Please visit support.climateinteractive.org for additional inquires and support.

1.8

Natural Gas

Discourage or encourage drilling and burning natural gas for energy. Natural Gas is a fossil fuel that is used
for electricity, heating, and industry. When burned, it releases carbon dioxide (although less than coal and oil) and,
if leaked into the air, it contains high amounts of methane. Natural gas drilling uses large amounts of water and can
cause contamination.

1.8.1 Examples
• Governments implementing laws against fracking and taxes on natural gas.
• Financial services industry (e.g., banks) or global development institutions (e.g., World Bank) limiting access to
capital.

1.8.2 Big Message
• More natural gas is not an effective long-term strategy for the climate – it is less carbon intensive than coal, but
its infrastructure has a long life so it competes with the adoption of lower-carbon alternatives as they scale up.

1.8.3 Key Dynamics
• If gas is taxed, in absence of other policies, primary energy demand for natural gas decreases, but high-carbon
coal and oil demand increases slightly. We call this the “squeeze the balloon” problem – depressing fossil fuel
emissions in one area causes them to pop up in another. Adding a carbon price is a good solution to the “squeeze
the balloon” problem, as it addresses all fossil fuels together.
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1.8.4 Potential Co-Benefits of Discouraging Natural Gas
• Gas drilling is water intensive, so limiting extraction can improve water security and quality at the source of
production and protect wildlife habitats, biodiversity, and ecosystem services.12
• There are concerns about the health and environmental impacts of the gas drilling approach, known as fracking,
that have led many places to ban it.345

1.8.5 Equity Considerations
• Generally speaking, natural gas production in developed countries is disproportionately located near low-income
and minority communities.67
• There have been cases where wealthy white communities have successfully resisted natural gas development and
it has shifted to low-income communities predominantly inhabited by people of color. Low income communities
often have less ability to influence development.89
• Limited data on the placements of fracking and power plant sites in developing countries exists, yet macrolevel research shows that low-income communities and communities of color disproportionately experience the
negative impacts of natural gas drilling and burning.10

1.8.6 Slider Settings
The following table highlights the numerical ranges for the labelled input levels of the Natural Gas slider. Each of the
energy supply sliders is set to reflect a similar percentage cost increase or decrease for each input level.

Change in price per thousand cubic feet (Mcf)
Cost increase or decrease

very highly
taxed
+$5.00
to
+$2.00
+200%
to
+60%

highly
taxed
+$2.00
+$1.00
+60%
+30%

taxed
to
to

+$1.00
+$0.30
+30%
+10%

to
to

status quo

subsidized

+$0.30 to $0.30
+10% to 10%

-$0.30 to $1.00
-10% to 30%

1 Bamberger, M., & Oswald, R. E. (2012). Impacts of Gas Drilling on Human and Animal Health. NEW SOLUTIONS: A Journal of Environmental and Occupational Health Policy, 22(1), 51–77. https://doi.org/10.2190/NS.22.1.e
2 Ridlington, E., & Rumpler, J. (2013). Fracking by the Numbers: Key Impacts of Dirty Drilling at the State and National Level. Environment
America. Retrieved from https://environmentamerica.org/sites/environment/files/reports/EA_FrackingNumbers_scrn.pdf
3 Good, K. (2015, February 12). These 4 Countries Have Banned Fracking . . . Why Can’t the U.S. Get On Board? Retrieved from https:
//www.onegreenplanet.org/environment/countries-except-united-states-that-have-banned-fracking/
4 Food & Water Watch. (2019, August 12). Local Resolutions Against Fracking. Retrieved from https://www.foodandwaterwatch.org/insight/
local-resolutions-against-fracking
5 Carpenter, D. O. (2016). Hydraulic fracturing for natural gas: impact on health and environment. Reviews on Environmental Health, 31(1).
https://doi.org/10.1515/reveh-2015-0055
6 Clough, E. (2018). Environmental justice and fracking: A review. Current Opinion in Environmental Science & Health, 3, 14–18. https:
//doi.org/10.1016/j.coesh.2018.02.005
7 Bienkowski, B. (2016, February 17). Fracking’s Costs Fall Disproportionately on the Poor and Minorities in South Texas. Inside Climate
News. https://insideclimatenews.org/news/10022016/poor-minorities-carry-burden-fracking-waste-south-texas-eagle-ford-shale
8 Jula,
M. (2018,
April 17).
Parents didn’t want fracking near their school.
So the oil company
chose
a
poorer
school,
instead.
Mother
Jones.
https://www.motherjones.com/environment/2018/04/
an-oil-company-faced-pushback-about-fracking-near-a-charter-so-it-moved-next-to-a-low-income-public-school/
9 Gislason, M., & Andersen, H. (2016). The Interacting Axes of Environmental, Health, and Social Justice Cumulative Impacts: A Case Study
of the Blueberry River First Nations. Healthcare, 4(4), 78. https://doi.org/10.3390/healthcare4040078
10 Perera, F. (2017). Pollution from Fossil-Fuel Combustion is the Leading Environmental Threat to Global Pediatric Health and Equity: Solutions
Exist. International Journal of Environmental Research and Public Health, 15(1), 16. https://doi.org/10.3390/ijerph15010016
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1.8.7 Model Structure
The cost of natural gas affects three significant decisions regarding energy infrastructure:
1. Investment in new capacity (whether or not to build new processing and power plants);
2. use of capacity (whether to run existing plants);
3. retirement of capacity (whether to keep plants longer or shorter than the average of ~30 years).

1.8.8 FAQs
How can I directly force deeper reductions in natural gas use? Consider selecting the “Stop building new natural
gas infrastructure” switch in the advanced view, and changing the “% Reduction in gas utilization” slider.
Please visit support.climateinteractive.org for additional inquires and support.

1.9

Bioenergy

Discourage or encourage the use of trees, forest waste, and agricultural crops to create energy. Bioenergy is
energy produced from the burning, or combustion, of living organic material such as wood, algae, or agricultural
crops. There are a variety of bioenergy sources, some of which can be sustainable and others which can be worse than
burning coal.

1.9.1 Examples
• Government incentives and/or targets to convert land into growing biofuel feedstocks and drive bioenergy development.
• Research, development, and investment into new technologies that can produce new forms of biofuels, and
vehicles and industry that can use or support these biofuels.

1.9.2 Big Message
• Bioenergy is not a high leverage response to climate change – while it uses a renewable resource, it still emits
large amounts of carbon dioxide and faces supply constraints with scale up.

1.9.3 Key Dynamics
• As bioenergy is subsidized or taxed, notice that the temperature changes very little. Changes in bioenergy
shift the amount of other energy sources, which can mean things like more coal if bioenergy is taxed or less
renewables if bioenergy is subsidized.
• Bioenergy is only zero-carbon if the feedstock is regrown to account for the carbon emitted. In some areas,
trees are being used for bioenergy, which will take decades to regrow to make up for the carbon released when
burned.
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1.9.4 Potential Co-Benefits of Discouraging Bioenergy
• Crops and arable land are freed for other uses, such as food production when bioenergy is discouraged.
• Leaving sources of biomass, like forests, intact enables biodiversity to be preserved.
• A reduction in biomass burning can improve indoor and outdoor air quality from reduced soot and particulates.
• Bioenergy can accelerate deforestation through dependence on wood for fuels or through the expansion of
bioenergy crops, particularly in the tropics. Less deforestation has many benefits including additional carbon
sequestration.

1.9.5 Equity Considerations
• Land used for bioenergy crops can reduce land availability for food production and compromise food security.
• Farmer livelihoods can be severely impacted by shifting agriculture markets, so steps should be taken to help
workers and farmers transition to shifting crop demands.

1.9.6 Slider Settings
The following table highlights the numerical ranges for the labelled input levels of the Bioenergy slider. Each of the
energy supply sliders is set to reflect a similar percentage cost increase or decrease for each input level.

Change in price per barrel of oil
equivalent (boe)
Cost increase or decrease

highly
taxed
+$30
+$15
+60%
+30%

taxed
to
to

+$15
+$5
+30%
+10%

status quo
to

+$5 to -$5

subsidized
-$5 to -$15

to

+10% to 10%

-10% to 30%

highly subsidized
-$15 to -$30
-30% to -60%

1.9.7 Model Structure
• This sector tracks several stages of bioenergy installations, or energy supply capacity including: capacity under
development, under construction, and actually producing energy, as well as the delays between each stage.
• Future modeling in this sector will add more refinement to the ways the bioenergy supply is characterized and
include stronger links to the amount of available land.
Please visit support.climateinteractive.org for additional inquires and support.

1.10

Renewables

Encourage or discourage building solar panels, geothermal systems, and wind turbines. Renewable energy
includes wind, solar, geothermal, hydropower, and other technologies that produce energy with little to no carbon
dioxide emissions. Note that nuclear and bioenergy are considered separately.

1.10. Renewables
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1.10.1 Examples
• Governments offering tax incentives to families installing solar panels on their roofs.
• Farmers and land owners allowing the installment of wind turbines on their land.
• Research and development for improvements to renewable energy technologies in order to improve efficiencies
and/or reduce costs.
• Businesses committing to powering themselves with 100% renewable energy.

1.10.2 Big Message
• Subsidizing renewable energy helps to limit coal and gas demand and reduce future temperature. Without other
actions, however, it isn’t enough to keep fossil fuels in the ground.

1.10.3 Key Dynamics
• Impact. As you encourage renewables, watch demand for Renewables (in green) grow and the demand for
Coal (in brown) and Natural Gas (in blue) reduce in the “Global Sources of Primary Energy” graph. Renewable
energy is already growing steadily in the Baseline scenario so the additional subsidies help reduce emissions but
only so much.
• Price-demand feedback. Additionally, subsidies to renewables decrease energy costs, which increase energy
demand over what it would have been otherwise (people use more energy when it is cheap). This feedback
effect somewhat reduces the positive impact of encouraging renewable energy. View this dynamic with the
graph “Final Energy Consumption.”
• Delays. It takes time for the subsidies and encouragement of renewables to show up in installed capacity.
Subsidies are phased in over 10 years so note in the “Renewable Final Energy Consumption” graph that the
Current Scenario does not immediately differ from the Baseline.

1.10.4 Potential Co-Benefits of Encouraging Renewables
• Decreased air and water pollution from switching away from fossil fuel sources can improve public health,
worker productivity, and savings for governments and households.
• Renewables can help expand energy access during power outages.
• Renewable energy offers opportunities for high- and low-skilled employment.

1.10.5 Equity Considerations
• Although the price of renewable energy infrastructure continues to fall, many low-income communities remain
unable to access the technology in both developed and developing countries. Working to ensure an equitable
energy transition can help everyone to reap the benefits.1
• Policies in many developed countries limit solar and wind subsidy programs to homeowners, who often occupy
higher income brackets.
1

22

Eisenberg, A. (2018). Just Transitions. Southern California Law Review, Vol. 92, No. 101, 2019. https://ssrn.com/abstract=3281846

Chapter 1. Table of Contents

En-ROADS Guide Documentation

1.10.6 Slider Settings
The following table highlights the numerical ranges for the labelled input levels of the Renewables slider. Each of the
energy supply sliders is set to reflect a similar percentage cost increase or decrease for each input level.

Change in price per kilowatt hour
(kWh)
Cost increase or decrease

taxed

status quo

subsidized

+$0.02
to
+$0.01
+30% to +10%

+$0.01
to
-$0.01
+10% to -10%

-$0.01
to
-$0.02
-10% to -30%

highly
subsidized
-$0.02 to -$0.03
-30% to -60%

1.10.7 Model Structure
This sector tracks the time it takes wind and solar installations to move through several stages – capacity under
development, under construction, and actually producing energy.
The most important feedback loops in the renewables sector include:
1. Overheating – costs go up when demand grows faster than the manufacturing and support industries can keep
up.
2. Site availability – efficiency goes down and costs go up when renewables are sited in less optimal locations (e.g.,
solar power in rainy climates).
3. Learning effect – every doubling of cumulative production will bring costs down 20% (aka, the progress ratio).
Costs come down as supply chains, business models, and production industries grow.

1.10.8 Case Studies
United States: Scaling up wind and solar energy sources is estimated to have avoided 7,000 premature deaths and
saved $87.6 B in health costs and climate impacts from 2007-2015.2
Benin: Solar-powered drip irrigation for women farmers was shown to increase household vegetable production and
consumption, increase income level, and decrease food insecurity.3
Global: Increasing the share of renewable energy in the global energy supply to 65% could generate 6 million jobs
and add $19 trillion to the world economy by 2050.4

1.10.9 FAQs
Why doesn’t encouraging renewables with a big subsidy avoid much future warming alone?
• Renewables only reduce CO2 emissions when they displace fossil fuels. In some cases renewable energy just
meets new energy demand and doesn’t replace the demand met by coal and gas.
• Second, there is a price-demand feedback effect – in order to grow, renewables are made less expensive. The
drop in energy price boosts demand, undoing some of the positive effect.
How can I get renewables to grow faster?
2

Millstein, D., Wiser, R., Bolinger, M., & Barbose, G. (2017). The climate and air-quality benefits of wind and solar power in the United States.
Nature Energy, 2(9). https://doi.org/10.1038/nenergy.2017.134
3 Burney, J., Woltering, L., Burke, M., Naylor, R., & Pasternak, D. (2010). Solar-powered drip irrigation enhances food security in the Sudano–Sahel. Proceedings of the National Academy of Sciences, 107(5), 1848–1853. https://doi.org/10.1073/pnas.0909678107
4 IEA/IRENA. (2017) Perspectives for the Energy Transition – Investment Needs for a Low-carbon Energy System. Paris/Abu Dhabi:
IEA/IRENA. https://www.irena.org/DocumentDownloads/Publications/Perspectives_for_the_Energy_Transition_2017.pdf
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• Discourage coal and oil by taxing them individually or setting a carbon price.
• Adjust the “Renewables R&D breakthrough cost reduction” slider to simulate a sudden breakthrough that would
dramatically lower the cost of renewable energy.
How do you handle the availability and cost of storage of electricity from renewables?
• The cost of storage for renewables is explicitly modeled in En-ROADS, and as renewables become a significant
part of energy supply, storage must be cost effective to enable further expansion.
Please visit support.climateinteractive.org for additional inquires and support.

1.11

Nuclear

Encourage or discourage building nuclear power plants. Nuclear power production does not release carbon dioxide, but it produces harmful nuclear waste.

1.11.1 Examples
Discouraging
• Public information campaigns to raise public concerns about the risks of nuclear power.
• Policies to retire existing nuclear power plants.
Encouraging
• Government policies aimed at handling nuclear waste and reducing costs of nuclear power.
• Corporate efforts to promote public acceptance of nuclear power plants.

1.11.2 Big Message
• Nuclear is not a huge driver of future temperature and competes with the growth of renewables and new zerocarbon technology.
• It could be part of a suite of climate action if one is willing to accept the environmental costs – e.g., handling
waste materials and the risk of radiation damage near the plants.

1.11.3 Key Dynamics
• As you subsidize nuclear, watch Nuclear (light blue area) grow, and Coal (brown area) and Natural Gas (dark
blue area) decrease in the “Global Sources of Primary Energy” graph. Nuclear displaces some fossil fuel sources,
which keeps more carbon in the ground and helps reduce temperature modestly.
• Nuclear competes with all energy sources available, so notice also what happens to Renewables (green area)
when nuclear is incentivized —it decreases too.
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1.11.4 Potential Co-Benefits of Discouraging Nuclear
• Risk of exposure to radiation from a nuclear meltdown or hazardous waste is reduced.
• Nuclear energy can use more water than coal for electricity production, so discouraging nuclear power can
increase water security and help protect wildlife habitats, biodiversity, and ecosystem services.1
• Nuclear energy is fueled by uranium which can be harmful to mine, so discouraging nuclear energy can reduce
risks to miners.

1.11.5 Equity Considerations
• Nuclear power plants, uranium mines (which provide the fuel for nuclear power), and waste sites are often located in low-income, marginalized communities that often lack resources to advocate for stricter environmental
regulations and oversight.2
• Mining uranium poses significant health risks to miners as well as surrounding communities due to water contamination and toxic waste.

1.11.6 Slider Settings
The following table highlights the numerical ranges for the labelled input levels of the Nuclear slider. Each of the
energy supply sliders is set to reflect a similar percentage cost increase or decrease for each input level.

Change in price per kilowatt
hour (kWh)
Cost increase or decrease

highly taxed

taxed

+$0.07
+$0.03
+60%
+30%

+$0.03
+$0.01
+30%
+10%

to
to

to
to

status quo

subsidized

+$0.01 to $0.01
+10% to 10%

-$0.01 to $0.03
-10% to 30%

highly subsidized
-$0.03
to
-$0.07
-30% to -60%

1.11.7 Model Structure
This sector tracks several stages of nuclear power plants, or energy supply capacity: capacity under development,
under construction, and actually producing energy, including delays between each stage.
Please visit support.climateinteractive.org for additional inquires and support.

1.12

New Zero-Carbon

Discover a brand-new cheap source of electricity that does not emit greenhouse gases. Some speculate that such
a breakthrough could be nuclear fusion or thorium-based nuclear fission. Decide when the breakthrough occurs, its
initial cost relative to coal, and how long the delays in commercialization and scale up would be.
1

Union of Concerned Scientists. (2013, July). How it Works: Water for Nuclear. https://www.ucsusa.org/resources/water-nuclear
Kyne, D., & Bolin, B. (2016). Emerging Environmental Justice Issues in Nuclear Power and Radioactive Contamination. International Journal
of Environmental Research and Public Health, 13(7), 700. https://doi.org/10.3390/ijerph13070700
2
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1.12.1 Examples
• Research and development, or other investment into new sources of energy supply such as thorium fission or
nuclear fusion.
• Note, this does not include new technologies in CO2 removal, transportation, electrification, or energy efficiency.

1.12.2 Big Message
• The potential contribution of a new energy supply technology is severely hampered by the long amount of time
it takes new technologies to scale up. Even under optimal conditions, it would take decades to displace fossil
fuels, and actually reduce greenhouse gas emissions.

1.12.3 Key Dynamics
• Watch the orange area of New Zero-Carbon go up as a breakthrough in a new zero-carbon energy supply occurs
in the “Global Sources of Primary Energy” graph. Notice that temperature drops only modestly. There are two
reasons why:
– First, notice it takes a long time for the new technology to grow and become a large part of the global energy
mix. There is a long delay between discovery of the zero-carbon energy technology and its dominance in
the market – 10 years to commercialize, several years to plan and build, and then growing only as existing
coal and natural gas plants (which have a lifetime of 30 years) are retired. Watch how little Coal (brown
area) and Natural Gas (dark blue area) go down before 2040. Because of this, very little carbon is kept
underground during this critical period.
– Second, look at the “Final Energy Consumption” graph. The reason the new zero-carbon technology grows
quickly is that it is cheaper than all other energy supplies, so the abundance of inexpensive energy increases
demand to higher than it would be otherwise.

1.12.4 Potential Co-Benefits of a Breakthrough in New Zero-Carbon
• A breakthrough in a new energy sources would create jobs along the supply chain from research and development to construction to operations.
• Research advancements in new technologies may be useful for other applications.

1.12.5 Equity Considerations
• There are unknown consequences and risks associated with new energy sources, and oftentimes these technologies can end up being located in vulnerable communities.

1.12.6 Slider Settings

Breakthrough year
Time to commercialize
Initial cost relative to coal
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status quo

breakthrough

huge breakthrough

no breakthrough

2022
10 years

2022
10 years
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1.12.7 Model Structure
The path to deployment will take some time after the success of the technology in the laboratory: commercialization (set at 10 years, roughly the same amount of time that Uranium-based fission took), planning (2 years), and
construction (5 years). Then the new energy source must compete with other energy sources.
Please visit support.climateinteractive.org for additional inquires and support.

1.13

Carbon Pricing and Energy Standards

Set a global carbon price that makes energy sources more expensive depending on how much carbon dioxide they release, or enact a clean electricity standard or emissions performance standard. Energy producers
frequently pass additional costs to their customers, so policy must be designed to minimize the impacts on the poorest.

1.13.1 Examples
• Countries and regions implementing carbon taxes.
• Grassroots campaigns generating public support for carbon pricing.
• Clean Electricity Standards are similar to Renewable Portfolio Standards in use in several US States or the
Renewables Obligation in the UK.

1.13.2 Big Message
• Pricing carbon is a high leverage strategy, as it both reduces the carbon intensity of the energy supply and
reduces the overall energy demand.
• Clean Electricity Standards only affect part of the energy system, and so their leverage depends on being used
in conjunction with electrification of transport and buildings and industry.

1.13.3 Key Dynamics
• When the carbon price is increased, notice that Coal (brown area) reduces the most in the “Global Sources of
Primary Energy” graph. It is the most carbon intensive source of energy, which makes it the most sensitive to a
carbon price. Natural Gas (dark blue area) decreases as well, although more modestly. Oil (red area) decreases
only slightly, even though it is more carbon intensive than gas, because it is not easily substituted for other
energy sources (e.g. can’t power a diesel truck with wind power). Renewables (green area) increases as the
relative cost of wind and solar make them more attractive.
• Just like taxing coal, a significant carbon price increases energy costs, which reduces energy demand. View
this in the “Final Energy Consumption” graph, noting that the high carbon price Current Scenario (blue line) is
lower than Baseline (black line).
• The economic effects of these policies are best seen as the cost of energy plus the cost of subsidies minus the
revenue from taxes. See the two graphs “Total Annual Cost of Energy” and “Revenue & Cost from Taxes &
Subsidies.”

1.13. Carbon Pricing and Energy Standards
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1.13.4 Potential Co-Benefits of a Carbon Price
• Renewable energy becomes relatively cheaper, which can incentivize job creation in the sector.
• Reducing the use of fossil fuels improves air quality, increasing healthcare savings and worker productivity.
• Revenue from carbon pricing can be allocated to social programs that can be shared with everyone.

1.13.5 Equity Considerations
• As carbon taxes reach effective levels, companies may try to pass costs to customers, where the poor are most
at risk of being impacted. Policies can be developed that limit this impact.
• Workers employed in fossil fuel industries risk losing their jobs if companies shrink workforces in response to
higher costs of production, so job transition plans should be in place and protections for workers ensured.
• Due to the political nature of fossil fuel production, government corruption and rent-seeking could create the
possibility of certain industries avoiding the carbon price due to loop holes or exemptions.

1.13.6 Slider Settings

Carbon price per ton

status quo

low

medium

high

very high

no carbon price

$0 to $20

$20 to $60

$60 to $100

$100 to $250

Clean Electricity Standard
The switch “Use clean electricity standard” sets a policy which requires a certain percentage of electricity to come
from qualifying sources. This creates a system of incentives: producers of qualifying electricity receive additional
revenue, like a subsidy except that the money comes through electricity prices rather than government spending. The
added costs and revenues affect electricity markets and investment, pushing the mix of generation toward the target
standards. The value of the incentive depends on the gap between target and actual generation, and on how ambitious
the target is.
Under “Sources that qualify as clean electricity,” check the boxes for which sources qualify as “clean.” You can see the
percent these sources contribute on the graph “% Electricity Consumption from Qualifying Sources.” Use the “Target
% electricity from qualifying sources” slider to set the required amount of qualifying electricity.

1.13.7 Case Studies
Northeast United States: A 2016 MIT study examined a scenario where the Northeast United States implemented a
carbon cap and trade program and found that the annual health savings to the region could be five times greater than
the costs of the changes needed to satisfy the policy.1
Please visit support.climateinteractive.org for additional inquires and support.
1 Thompson, T. M., Rausch, S., Saari, R. K., & Selin, N. E. (2016). Air quality co-benefits of subnational carbon policies. Journal of the Air &
Waste Management Association, 66(10), 988–1002. https://doi.org/10.1080/10962247.2016.1192071
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1.14

Transport – Energy Efficiency

Increase or decrease the energy efficiency of vehicles, shipping, air travel, and transportation systems. Energy
efficiency includes things like hybrid cars, expanded public transport, and ways that people can get around using less
energy. Adopting more energy efficient practices, such as cycling and walking, can improve public health and save
money.

1.14.1 Examples
• Individuals changing their personal behavior to increase walking, biking, using public transit, carpooling, living
in higher density neighborhoods, purchasing more efficient vehicles, reducing flying, or telecommuting.
• Public or corporate policies such as increasing parking prices, investing in public transit, offering tax breaks
for efficient vehicles, rewarding carpooling, building bike lanes, creating high density pedestrian friendly urban
areas, or performance standards that mandate specific fuel efficiency.
• Research and development into high efficiency technologies for shipping, vehicles, and air travel.

1.14.2 Key Dynamics
• Watch Oil (red area) decrease in the “Global Sources of Primary Energy” graph as the world increases the
efficiency of its transport. Less oil is burned, and coal and gas fall as well as electrified transport becomes more
efficient.
• View the “Final Energy Consumption” graph to see the fall in energy demand.
• To see another benefit, look at the “Cost of Energy” graph. Less demand for energy means prices are lower.

1.14.3 Potential Co-Benefits of Encouraging Energy Efficiency
• Improved air quality as a result of less burning of fossil fuels increases healthcare savings and worker productivity.
• Better fuel efficiency means energy costs are lower.
• Mass transit, like buses and trains, can reduce traffic congestion and noise.
• Improved biking and walking infrastructure increases physical activity and safety, which results in sizeable
health savings.

1.14.4 Equity Considerations
• In some developed countries, such as the United States, pedestrian and cycle-friendly infrastructure has been
concentrated in wealthy communities, leaving out low-income families and people of color.1
• When mass transit options improve or operating costs decrease with fuel efficient vehicle use, social equality
may improve, as low-income individuals have more transportation options to meet their needs.
1 Lusk, A. (2019, August 23). Stop Designing Bike-Friendly Cities Only for Wealthy White Cyclists. City Lab. https://www.citylab.com/
transportation/2019/02/bike-friendly-cities-should-be-designed-everyone/582409/

1.14. Transport – Energy Efficiency
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1.14.5 Slider Settings
The variable being changed is the annual improvement rate in the energy intensity of new transport capital such as
vehicles, trains, and ships.

Annual rate

discouraged

status quo

increased

highly increased

-1% to 0%

0% to +1%

+1% to +3%

+3% to +5%

1.14.6 Model Structure
Increasing the improvement rate in energy use for new vehicles and other infrastructure helps drive reductions in
greenhouse gas emissions across the transport sector. There is some delay in how fast this accelerates because energy
use is driven by the overall average of all capital (not just the new things). The model structure tracks overall efficiency,
which includes retrofitting of existing capital.

1.14.7 Case Studies
New York City: A program that supports students walking and biking to school spent $10 million and saved $230
million from increased physical activity, reduced air pollution, and decreased injury rates.2
Barcelona, Spain: Replacing 20% of Barcelona’s car trips with bikes could save 38 lives per year from decreased air
pollution and increased physical activity, while also reducing 21,000 tons of CO2 per year.3
Please visit support.climateinteractive.org for additional inquires and support.

1.15

Transport – Electrification

Increase purchases of new electric cars, trucks, buses, trains, and possibly even ships and airplanes. Using
electric motors for transport helps reduce greenhouse gas emissions and air pollution if the electricity is from lowcarbon sources like solar and wind.

1.15.1 Examples
• Investments into electric vehicle charging infrastructure.
• Research and development into the technologies for vehicles, batteries, and charging.
• Corporate commitments to sales of electric vehicles.
• Programs to offer rebates and incentives to electric car purchases.
2 Muennig, P. A., Epstein, M., Li, G., & Dimaggio, C. (2014). The Cost-Effectiveness of New York City’s Safe Routes to School Program.
American Journal of Public Health, 104(7), 1294–1299. https://doi.org/10.2105/AJPH.2014.301868
3 Rojas-Rueda, D., Nazelle, A. D., Teixidó, O., & Nieuwenhuijsen, M. (2012). Replacing car trips by increasing bike and public transport in the
greater Barcelona metropolitan area: A health impact assessment study. Environment International, 49, 100–109. https://doi.org/10.1016/j.envint.
2012.08.009
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1.15.2 Big Message
• If the world is dependent on coal and natural gas for electric power, the net effect of electrification is only a
slight change in emissions and temperature.
• Switching to electric modes of transport makes the biggest impact for the climate when electrical energy sources
are low-carbon.

1.15.3 Key Dynamics
• As you increase Transport Electrification, there are two main forces that affect future temperature:
– Overall efficiency is greater for electrified transport than for internal combustion engines – in general, less
fuel is used to power transport with electricity than oil.
– Oil, in the “Global Sources of Primary Energy” graph, goes down as we electrify transport. At the same
time, primary energy demand for coal, renewables, and to a more limited extent, natural gas, all increase
to power the rise in electrical demand.

1.15.4 Potential Co-Benefits of Encouraging Electrification
• Improved air quality from fewer internal combustion engines increases healthcare savings and worker productivity.
• Jobs are created in the manufacturing and sales of electric batteries and engines.

1.15.5 Equity Considerations
• Although costs are coming down, electric vehicles may not be affordable or available to everyone.
• Mining of lithium and copper, two necessary ingredients for the batteries used in electric vehicles, can be
damaging to precious ecosystems and threaten the well-being of communities near mining sites.1
• Electric charging station locations may not be accessible or the electric battery range may be insufficient for
some situations.

1.15.6 Slider Settings
The main Transport Electrification slider adds a policy mandating the minimum percentage of new road and rail
transport (cars, trucks, buses, and trains) that must be powered by electricity rather than fuels.
Note that other actions can contribute to electrification and can result in higher levels of electrification than what the
slider target is set to.
With the “Electrification of new transport – air and water” slider in the advanced settings you can set the percentage of
new electric airplanes, ships, boats, etc. that use air or water to get around. Currently, electric airplanes and long-range
electric ships are only available as prototypes and face significant technological challenges due to the limitations of
energy storage, so the default assumption is that they do not scale up. If the slider is moved, then the percentage of
electrification action would begin in 2030 and take 70 years to reach the specified percentage.
1 Lombrana, L. M. (2019, June 11). Saving the Planet With Electric Cars Means Strangling This Desert. Bloomberg Green. https://www.
bloomberg.com/news/features/2019-06-11/saving-the-planet-with-electric-cars-means-strangling-this-desert

1.15. Transport – Electrification
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Minimum percentage of new transport

status quo

incentivized

highly incentivized

0% to 9%

10% to 49%

50% to 100%

1.15.7 Model Structure
This input directly forces growth of electrification up to a minimum percentage, unlike the inputs for energy sources,
which change the financial attractiveness to drive future behavior.
This input affects climate outcomes through two pathways:
1. Changing energy demand. The efficiency for electrified energy use is greater than for the direct burning of coal,
oil, and gas.
2. Changing fuel mix. Increased electrification decreases use of oil but then increases use of coal, natural gas, and
renewables in electricity generation.

1.15.8 Case Studies
United States: Increasing fuel economy standards in the United States could save consumers tens of billions of dollars
per year, reduce gas consumption by tens of billions of gallons per year, and create over 300,000 jobs by 2030 while
also reducing greenhouse gas emissions by millions of tons per year.2
Please visit support.climateinteractive.org for additional inquires and support.

1.16

Buildings and Industry - Energy Efficiency

Increase or decrease the energy efficiency of buildings, appliances, and other machines. Energy efficiency includes things like building well-insulated homes and reducing the amount of energy factories use. Energy efficient
practices can save money through reduced energy needs as well as improve the health of people in those buildings.

1.16.1 Examples
• Individuals and businesses insulating buildings, purchasing energy efficient technologies (motors, lighting, appliances, servers, HVAC systems), and conserving energy.
• Government policies such as tax breaks and performance standards to incentivize energy efficient products and
practices.
• Research and development into high efficiency technologies.
2 Bezdek, R. H., & Wendling, R. M. (2005). Potential long-term impacts of changes in US vehicle fuel efficiency standards. Energy Policy,
33(3), 407–419. https://doi.org/10.1016/j.enpol.2003.08.015
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1.16.2 Big Message
• Energy efficiency of buildings and industry is high leverage. It leads to less overall energy use, which leads to
less coal, oil, and gas being used. It also saves families, business, and communities money.

1.16.3 Key Dynamics
• As less energy is used for buildings and industry, notice how all the energy sources decline in the “Global
Sources of Primary Energy” graph - particularly coal and gas when they are the main sources of electricity. Less
fossil fuels are burned so CO2 emissions go down and global temperature change is lowered dramatically.
• Improvements in energy intensity of new capital also reduce energy demand. Explore this in the “Final Energy
Consumption” graph, where the Current Scenario (blue line) is lower than the Baseline (black line).

1.16.4 Potential Co-Benefits of Encouraging Energy Efficiency
• Increased industrial efficiency and reduced energy demand can reduce air pollution, which increases healthcare
savings and worker productivity.
• Lowering electricity bills for households, businesses, and governments increases energy security.
• Insulated homes remain cooler in the summer and warmer in the winter, when weather events and grid-overload
cause outages.
• Retrofitting buildings and homes to be more efficient can create many jobs.

1.16.5 Equity Considerations
• The up-front capital costs of efficiency improvements may not be accessible to lower income individuals and
small businesses.
• In some places, policies are directed at property owners, inhibiting renters, who are often lower income, from
accessing the benefits.

1.16.6 Slider Settings
The variable being changed is the annual improvement rate in the energy intensity of new capital for buildings and
industry.

Annual rate

discouraged

status quo

increased

highly increased

-1% to 0%

0% to +1.5%

+1.5% to +3%

+3% to +5%

1.16. Buildings and Industry - Energy Efficiency
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1.16.7 Model Structure
Increasing the rate of improvement in energy use for buildings and industry lowers emissions gradually, because
energy use is driven by the overall average of all infrastructure in this area, which is delayed from this intervention
because improvement only come to new things and many buildings and industrial facilities last decades.

1.16.8 Case Studies
Global: Through LEED-certified energy efficient buildings, a group of six major economies saved $13.3 billion in
energy, health, and climate benefits and avoided emitting dozens of air pollutants.1
United Kingdom: If the UK were to reduce its household energy expenditures by one-quarter using energy efficiency
measures, households could save £270 per year. The net present value of this investment is £7.5 billion, and the wider
health, economic, and energy benefits could reach £47 billion.2
Please visit support.climateinteractive.org for additional inquires and support.

1.17

Buildings and Industry - Electrification

Increase the use of electricity, instead of fuels like oil or gas, in buildings, appliances, heating systems, and other
machines. Using electric motors only helps reduce emissions if the electricity is from low-carbon sources like solar
and wind.

1.17.1 Examples
• Increase in public interest for replacing oil and gas heating furnaces in buildings with electric heating systems.
• Research and development into various electric motors and systems that could enable wind and solar to replace
oil and gas fired industrial facilities.

1.17.2 Big Message
• Electrification of buildings and industry can help, particularly when renewable energy is already encouraged or
fossil fuels are discouraged.

1.17.3 Key Dynamics
• When there are more efficient electrical systems powering buildings and industries, notice that Natural Gas (dark
blue area) and Coal (brown area) move down in the “Global Sources of Primary Energy” graph.
1

P., M., X., C., J., B., J., C.-L., J., S., A., B., & J., A. (2018). Energy savings, emission reductions, and health co-benefits of the green building
movement. Journal of Exposure Science & Environmental Epidemiology, 28(4), 307–318. https://doi.org/10.1038/s41370-017-0014-9
2 Rosenow, J., Eyre, N., Sorrell, S., & Guertler, P. (2017). Unlocking Britain’s First Fuel: The potential for energy savings in UK housing.
Retrieved from https://www.e3g.org/docs/17_9_6_UKERC_CIED_briefing_final.pdf
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1.17.4 Potential Co-Benefits of Encouraging Electrification
• Improved air quality at the source increases healthcare savings and worker productivity.
• Eliminating demand for natural gas lines to buildings also eliminates the risks from fire and explosion.
• Noise pollution from motor engines, generators, and furnaces is reduced.
• Air quality for individuals working/living in and around the structures is improved, which increases healthcare
savings and worker productivity.

1.17.5 Equity Considerations
• The up-front capital costs of retrofitting buildings and heating systems to be entirely electric may not be accessible to lower-income individuals and small businesses.
• Exposure to household air pollution is unevenly distributed within and across countries, to which negative health
effects and poverty are strongly correlated.1

1.17.6 Slider Settings
The Buildings & Industry Electrification slider adds a policy mandating the minimum percentage of new building
construction, industry, and appliances that must be powered by electricity rather than fuels.
Note that other actions can contribute to electrification and can result in higher levels of electrification than what the
slider target is set to.

Minimum percentage of new buildings and industry

status quo

incentivized

highly incentivized

0% to 39%

40% to 69%

70% to 100%

1.17.7 Model Structure
This input directly forces growth of electrification up to a minimum percentage, unlike the inputs for energy sources,
which change the financial attractiveness to drive future behavior.
This input affects climate outcomes through two pathways:
1. Changing energy demand. The efficiency for electrified energy use is greater than for the direct burning of coal,
oil, and gas.
2. Changing fuel mix. Increased electrification decreases use of oil but then increases use of coal, natural gas, and
renewables in electricity generation.
Please visit support.climateinteractive.org for additional inquires and support.
1

World Health Organization.
health-impacts/en/

(2018, May 7).

Household air pollution: Health impacts.

1.17. Buildings and Industry - Electrification

https://www.who.int/airpollution/household/
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1.18

Population Growth

Assume higher or lower population growth. Population is a key driver of increased greenhouse gases; however, this
is also tied heavily to consumption habits. Women’s education and access to family planning could accelerate shifts
to smaller families worldwide.

1.18.1 Examples
• Different assumptions for future fertility rates and demographics.
• Greater empowerment of women and girls, resulting in lower fertility rates.
• Increased education on and access to reproductive health services.

1.18.2 Big Message
• Contrary to some people’s beliefs, population growth is not a silver bullet for addressing climate change.
• Decisions around population and family choice are very personal decisions and efforts to shift these decisions
have ethical implications in many cultures.

1.18.3 Key Dynamics
• Watch all the sources of energy change as you change population growth.

1.18.4 Potential Co-Benefits of Lower Growth
• Lower population growth reduces global consumption of resources.
• Ensuring safe access to family planning, reproductive health services, and women’s education enhances quality
of life and income for women.

1.18.5 Equity Considerations
• Policies around population should be voluntary and empower women to make the choices that are best for them.
• A higher percentage of women of color live in countries with severe gender inequities in access to education, full
economic and political participation, and adequate family planning. Reducing population growth necessitates a
large investment in that particular group.
• There is a history of women of color in both high- and low-income countries being forcibly sterilized to prevent
giving birth; this should never be encouraged.1234
1 Bi, S. (2015). Forced Sterilizations of HIV-Positive Women: A Global Ethics and Policy Failure. AMA Journal of Ethics, 17(10), 952–957.
doi: 10.1001/journalofethics.2015.17.10.pfor2-1510
2 White, H. (2014, May 28).
African women fight back against forced, coerced sterilizations. https://www.lifesitenews.com/news/
african-women-fight-back-against-forced-coerced-sterilizations
3 Nittle, N. K. (2020, January 9).
U.S. Government’s Role in Sterilizing Women of Color.
https://www.thoughtco.com/
u-s-governments-role-sterilizing-women-of-color-2834600
4 Blakemore, E. (2016, August 25). The Little-Known History of the Forced Sterilization of Native American Women. JSTOR Daily. https:
//daily.jstor.org/the-little-known-history-of-the-forced-sterilization-of-native-american-women/
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1.18.6 Slider Settings
The slider reflects the 95% probability range of population deviating from the United Nation’s medium population
growth path. The variable being changed reflects the global population by 2100, in billions of people.
lowest growth
UN Scenario
Population
in 2100

low end of UN’s
95% range
9.1 to 9.5 billion

low growth

9.5 to 10.5
billion

status quo
middle of of UN’s
95% range
10.5 to 11.4 billion

high growth

11.4 to 12.8
billion

highest growth
high end of UN’s
95% range
12.8 to 13.2 billion

1.18.7 Model Structure
Population gets multiplied with economic growth (GDP per capita) to equal total global GDP, or Gross World Product.
Please visit support.climateinteractive.org for additional inquires and support.

1.19

Economic Growth

Assume higher or lower growth in goods produced and services provided. Economic Growth is measured in Gross
Domestic Product (GDP) per person and is a key driver in energy consumption. Alternatives exist to meeting people’s
needs through economic frameworks not based on constant GDP growth.

1.19.1 Examples
• Global efforts to reduce overconsumption and embrace voluntary simplicity.
• Possible impacts on economic growth from the effects of climate change.

1.19.2 Big Message
• Slower economic growth would be a high leverage approach for avoiding future temperature increases, however,
there are lots of questions about how this might occur and be done in a way that is equitable.

1.19.3 Key Dynamics
• Population gets multiplied with GDP per capita to equal total global GDP, or Gross World Product. Increases
in this variable accelerate the exponential growth of GDP, arguably the most important driver of future carbon
dioxide emissions.
• Watch all the sources of energy change as you change economic growth.
• As you increase the economic damage caused by climate change, notice how this reduces the emissions, but
cannot halt the temperature increase even under extreme assumptions where the world’s GDP plummets.

1.19. Economic Growth
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1.19.4 Potential Co-Benefits of Lower Growth
• Focus may be shifted to alternative measures of prosperity that enhance people’s wellbeing, such as gross national happiness.
• Greater focus on resource conservation and less on material consumption can lead to less waste.

1.19.5 Equity Considerations
• Economic growth is tied to pulling people out of poverty worldwide. Although, in recent decades, many gains
in economic growth have gone to the world’s wealthiest. Regardless, policies must be tailored to specific local
and regional circumstances.
• When GDP growth slows or contracts, governments can incur higher budget deficits, often implementing austerity measures—cutting spending and raising taxes—to offset the difference. These reforms can severely impact
the poor and working class causing job losses and all the inequities that come with loss of livelihood.1

1.19.6 Slider Settings
Economic Growth

Long-term economic growth
Near-term economic growth

low growth

status quo

high growth

0.5% to 1.2%
1.7% to 2.1%

1.2% to 1.9%
2.2% to 2.9%

1.9% to 2.5%
3.0% to 3.7%

The “Long-term economic growth” slider is the main slider that is used for controlling economic growth, however,
more precise assumptions about economic growth can be set by also adjusting the “Near-term economic growth”
slider. This slider sets the initial global average growth in GDP per person. The slider “Transition time” is available
to change the amount of time it takes for the “Near-term economic growth” level to reach the “long-term economic
growth” level.
Reduction in GDP from Climate Impacts
The two sliders “Reduction in GDP at 2°C from climate impacts” and “Maximum reduction in GDP” (located in the
Assumptions menu under ‘Economic impact of climate change’) enable the user to explore the strength of the feedback
between climate impacts and economic growth. These two sliders are displayed on a single line since they are related
to each other. Maximum reduction in GDP cannot be smaller than Reduction in GDP at 2°C, hence they move together
if a user tries to move them past each other. To see the dynamics as you adjust these sliders, view the graph “Reduction
in GDP vs Temperature.“
Climate change is expected to have multiple adverse effects on the economy, such as decreased investment in goods
and services due to the cost of responding to changes in extreme weather events, sea level rise, desertification, crop
yield decreases, flooding, and resulting migration. Several economists formulated this impact, known as the “damage
function,” as a percentage reduction on global GDP, and estimated it as a function of temperature change. The four
main functions in the literature are from Nordhaus (2017), Weitzman (2012), Dietz & Stern (2015) and Burke et al.
(2015). You can see their estimates for economic damage in the “Reduction in GDP vs Temperature” graph, and
replicate them in En-ROADS by entering the following values for the two sliders, or by selecting the function in the
‘Preset’ menu:
1 Ruckert, A., & Labonté, R. (2017). Health inequities in the age of austerity: The need for social protection policies. Social Science & Medicine,
187, 306–311. https://doi.org/10.1016/j.socscimed.2017.03.029
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En-ROADS Slider
Reduction in GDP at 2ºC
Maximum reduction in GDP

Nordhaus
0.9%
22%

Weitzman
1.3%
97%

Dietz & Stern
2.6%
98%

Burke
13%
20%

1.19.7 Model Structure
In the real world, there would be multiple feedbacks to economic growth from energy prices, and various taxes,
however, the model only features the feedback from climate impacts to GDP. The user can explore the other feedbacks
by changing economic growth projections with the sliders manually.
Please visit support.climateinteractive.org for additional inquires and support.

1.20

Methane & Other Gases

Decrease or increase greenhouse gas emissions from methane, nitrous oxide, and the F-gases. Methane is released
from sources like cows, agriculture, natural gas drilling, and waste. Nitrous oxide comes from fertilizers. The f-gases,
includes HFCs, PFCs, and others that are used in industry and consumer goods like air conditioners.

1.20.1 Examples
• Decreased meat consumption.
• Modified agricultural practices such as increasing digestion of manure and decreasing fertilizer use.
• Decreased methane leakage from oil and gas industries.
• Increased capturing of gases emitted from landfills.
• Research and development into substitutions for F-gases in industrial processes.

1.20.2 Big Message
• Reducing methane, nitrous oxide, and the F-gases is high leverage, although many approaches to reducing these
emissions need more research and support to scale up.

1.20.3 Key Dynamics
• Methane, N2 O, and F-gas emissions comprise 30% of current greenhouse gas emissions and are key in reducing
to address climate change.

1.20. Methane & Other Gases
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1.20.4 Potential Co-Benefits of Decreasing Methane & Other Gases
• Plant-based diets have been shown to be healthier for individuals and have less impact on ecosystems.
• Sustainable and plant-based agriculture produces more food with fewer resources, which increases food security.
• Reducing methane leakage from natural gas systems can save money.
• Less nitrogen-rich fertilizer run off can reduce water pollution, decrease eutrophication, and increase marine
health.

1.20.5 Equity Considerations
• Many cultural values are attached to certain foods, meaning change to more plant-based diets could require a
large societal shift.
• Policies implemented without care may threaten food security for certain individuals and communities. For
example, rice paddies, a large methane contributor, are a main dietary staple for many countries.
• Local economies and employment can be threatened in communities which currently rely on industrial, largescale farming practices as their main livelihood.

1.20.6 Slider Settings
The variable being changed is the percent reduction or increase of total maximum action. The model limits how
much these emissions can be reduced–so 100% max reduction is not a 100% total emissions reduction–since some are
considered unavoidable, particularly those from agriculture, landfills, and wastewater.

Percent reduction or increase of maximum
action

highly
duced
-100%
-50%

reto

moderately
duced
-50% to -2%

re-

status
quo
-2% to 0%

increased
0%
+10%

to

1.20.7 Model Structure
Each greenhouse gas is modeled separately within En-ROADS, which enables the impact of each gas on global temperature to be handled without using global warming potential (GWP) and CO2 equivalency conversions. Greenhouse
gases other than CO2 that are reflected in graphs with the units CO2 e do use GWP100 to enable comparison and reporting of all greenhouse gases together. This means that the short-lived, but high impact, nature of greenhouse gases
like methane is captured.

1.20.8 Case Studies
Carrboro, NC, USA: Participation in a community gardening program in Carrboro, NC showed improvements in childhood obesity levels and resulted in families with children in the program eating one-third more fruits and vegetables
every day.1
Please visit support.climateinteractive.org for additional inquires and support.
1 Castro, D. C., Samuels, M., & Harman, A. E. (2013). Growing Healthy Kids. American Journal of Preventive Medicine, 44(3). https:
//doi.org/10.1016/j.amepre.2012.11.024
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1.21

Deforestation

Decrease or increase the loss of forests for agricultural and wood product uses. Deforestation often entails burning and removing forests to clear land for crops like soybeans, corn, or palm oil. Forest protection efforts increase
biodiversity and can support community resilience.

1.21.1 Examples
• Government policy to preserve forested land and place restrictions on industries such as soybean and/or palm
oil.
• Increased support for indigenous land rights.
• Public support and campaigns to support land preservation.

1.21.2 Big Messages
• Efforts to reduce deforestation are relatively low leverage for the climate, because the influence from energy
CO2 emissions is so dominant, but stopping deforestation is still part of a multi-pronged effort to address climate
change.
• Protecting forests is helpful for many reasons other than climate action, including biodiversity conservation and
protection of native peoples’ lands.

1.21.3 Key Dynamics
• Highly reducing deforestation emissions reduces temperature less than most people would estimate. View the
“Greenhouse Gas Net Emissions by Gas – Area” graph to see the role of land use (deforestation) CO2 relative
to all the other sources of emissions.

1.21.4 Potential Co-Benefits of Decreasing Deforestation
• Forests protect biodiversity and provide ecosystem services and food sources.
• Forest preservation reduces erosion and prevents soil loss.
• Forests provide livelihoods for people (e.g., small-scale resource gathering and sustainable forestry) that can be
lost when land is shifted to other uses.

1.21.5 Equity Considerations
• Forest preservation efforts have sometimes restricted the land access of indigenous people who have lived sustainably on the land for generations. Policies should be created with local stakeholder engagement.12
1

Salopek, P. (2019, May 16). Millions of indigenous people face eviction from their forest homes. National Geographic. https://www.
nationalgeographic.com/culture/2019/05/millions-india-indigenous-people-face-eviction-from-forests/
2 Mwijuke, G. (2018, January 12). Batwa of Uganda mired in extreme poverty. Chwezitraveller. https://www.chwezitraveller.com/featured/
batwa-ugandas-conservation-refugees-mired-in-extreme-poverty/

1.21. Deforestation
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1.21.6 Slider Settings

Percent per year reduction or increase

highly reduced

moderately reduced

status quo

increased

-10% to -4%

-4% to -1%

-1% to 0%

0% to +1%

1.21.7 Model Structure
Emissions from deforestation stay level in the Baseline scenario to reflect trends that indicate deforestation continues
to be insufficiently addressed worldwide.
Please visit support.climateinteractive.org for additional inquires and support.

1.22

Afforestation

Plant new forests and restore old forests. As trees grow, they draw carbon out of the air, which reduces the concentration of carbon dioxide. However, without care, large-scale afforestation can compromise biodiversity and historical
land rights.

1.22.1 Examples
• Government policies, incentives, and funding to identify available land, plant trees, and manage forests.
• Business, land owner, and public support for large scale tree planting.

1.22.2 Big Message
• Afforestation has the potential to pull significant amounts of carbon dioxide out of the atmosphere, but land
availability and other effects should be considered. It would take an immense amount of land to make a large
impact on temperature change.

1.22.3 Key Dynamics
• Growing more trees boosts global removal of CO2 from the atmosphere, as photosynthesis pulls carbon into
biomass and soils. Watch the temperature decrease modestly as a result.
• Explore the graph “Land for Carbon Dioxide Removal.” The land area of India is 300 million hectares, so if we
were to forest an area of that size we would still not see much change in temperature.
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1.22.4 Potential Co-Benefits of Increasing Afforestation
• New forests can create new ecosystems and protect existing wildlife habitats, biodiversity, and ecosystem services.
• Larger and healthier tree canopies in cities reduce urban heat island effects and energy needed for heating and
cooling.
• Jobs are created in tree planting, care, and maintenance.

1.22.5 Equity Considerations
• Afforestation entails shifting large areas of land into forests. This can sometimes result in monocultures of trees
that are all the same age, which does not contribute to healthy biodiversity as much as natural forests.
• Large shifts in land can compromise historic land access, so involving low-income and minority communities,
including Indigenous peoples, in the process of policy development and implementation is essential.

1.22.6 Slider Settings
The Afforestation slider changes the percentage of available land that is used to grow new forests. 100% would mean
that 700 Mha of land are covered in forests. 700 Mha represents approximately 25% of current grassland area, nearly
10% of all land that is not currently forest, and just over the difference in forest area back in 1850 until now (i.e., there
is 630 Mha less forest area today than in 1850).

Percent available land for afforestation

status quo

low growth

medium growth

high growth

0% to +15%

+15% to +40%

+40% to +70%

+70% to +100%

1.22.7 Model Structure
The carbon sequestration of forests changes over time as the forest matures. Notice that net carbon removals are
different than total removals due to carbon loss in older or unhealthy forests.
Maximum amount of available land: With a growing time of 80 years for new forests and 2%/year in total forest
carbon loss, 700 Mha achieves an annual removal consistent with the mid-point of estimates of afforestation potential
from the 2018 ‘Greenhouse gas removal’ report by the Royal Society (range of 3-20 in CO2 GtonsCO2/year).
For higher removals, one can adjust the “Afforestation settings” within the Assumptions view. For example, to explore
the assumptions of the 2019 paper by Bastin et al., increase the slider “Max available land for afforestation” to 900mha
under Assumptions.

1.22.8 Case Studies
New York City, USA: Increasing urban tree density by 343 trees per square kilometer was shown to reduce the rate of
childhood asthma by 29% in New York City.1
Please visit support.climateinteractive.org for additional inquires and support.
1 Lovasi, G. S., Quinn, J. W., Neckerman, K. M., Perzanowski, M. S., & Rundle, A. (2008). Children living in areas with more street trees have
lower prevalence of asthma. Journal of Epidemiology & Community Health, 62(7), 647–649. http://dx.doi.org/10.1136/jech.2007.071894

1.22. Afforestation
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1.23

Technological Carbon Dioxide Removal

Pull carbon dioxide out of the air with new technologies that enhance natural removals or manually sequester
and store carbon. Carbon Dioxide Removal (CDR) technologies include: direct air capture, bioenergy with carbon
capture and storage (BECCS), biochar, and others (but not including coal or gas CCS). CDR is not yet used widely,
and most approaches face significant barriers to deployment.

1.23.1 Examples
• Advancements in various CDR technologies through research and development and government policies.
• Support from businesses, land owners, and general public to implement such technologies.

1.23.2 Big Message
• Technological Carbon Removal has the potential to pull significant amounts of carbon dioxide out of the atmosphere.
• Most of these technologies are still undergoing pilot testing, and do not exist at the level needed to deploy at a
large scale.

1.23.3 Key Dynamics
• View the graphs “Land for Growing CO2 -Removal Biomass” and “Land for Farming with CO2 Removal” and
note the total amount of land area that all the approaches might require.
• View the graph “Bulk Material for Mineralization” to see the scale of industrial production these approaches
entail.

1.23.4 Potential Co-Benefits of CDR Growth
• Nature-based carbon removal approaches like agricultural soil sequestration can help improve land holder and
farmer profits in some cases.
• The scale up of many carbon removal approaches would result in vast new industries and businesses which
would create jobs.

1.23.5 Equity Considerations
• Approaches like BECCS require large areas of land that in some cases could otherwise be used for food production.
• Many of the technological carbon removal approaches have not been developed at scale yet and pose unknown
risks and consequences to the communities they are situated within.

44

Chapter 1. Table of Contents

En-ROADS Guide Documentation

1.23.6 Slider Settings

Percent of maximum potential

status quo

low growth

medium growth

high growth

0% to +10%

+10% to +40%

+40% to +70%

+70% to +100%

1.23.7 Model Structure
The five methods of CO2 removal included are modeled independently. They each vary in their maximum sequestration
potential, the year they might start to scale up, how long it takes them to be phased in, and the carbon leakage rate over
time (stored carbon is not always permanent).
The default settings for the maximum potential of technological carbon removal (“% of max potential”) are sourced
from the midpoint of the ranges of the 2018 ‘Greenhouse gas removal’ report by the Royal Society (Table 2, Chapter
2). For example, moving the simulator’s biochar slider to “100% of max potential” increases removals up to 3.5
Gton/yr, which was taken from the report’s range of 2-5 Gton/yr. For higher removal, one can adjust the “Carbon
dioxide removal maximum” settings within the “Assumptions” view, up to the highest end of the range sourced from
the same report. For example, the biochar maximum can be increased to 5 Gton/yr.

1.23.8 FAQs
Why aren’t coal and gas carbon capture and storage (CCS) included here, and how can I increase them? We
think of coal and gas CCS as reducing CO2 emissions from coal and gas, not actually as removing CO2 from the
atmosphere. Both can be changed in the Advanced View that supports the Coal and Natural Gas sliders.
Where can I learn more about the different CDR types? Follow the links to find detailed fact sheets on these CDR
types: Agroforestry & Forestation, BECCS, Biochar, Direct Air Capture, Enhanced Mineralization, and Agricultural
Soil Carbon Sequestration.
Please visit support.climateinteractive.org for additional inquires and support.

1.24 Model Comparison - Historical
1.24.1 Table of Contents
1. Primary Energy Demand History
2. Final Energy Consumption History
3. Electricity Generated by Energy Source History
4. Marginal Cost of Wind, Solar, and Geothermal Electricity History
5. Emissions History
6. Atmospheric Concentrations History
7. Radiative Forcing History
8. Temperature History
The purpose of this section of the En-ROADS User Guide is to supplement the historical comparison graphs in the
En-ROADS application by sharing multiple comparisons of En-ROADS model behavior compared against measured
historical data.

1.24. Model Comparison - Historical
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En-ROADS uses historical data for two purposes: initialization of the simulation and calibration. Certain variables
in En-ROADS are initialized with their measured historical values from 1990, and then the model runs. We compare the model output from 1990 through present day to measured historical data to identify opportunities for model
improvement.
The graphs below compare the En-ROADS Baseline scenario to measured historical data for select variables. Not all
variables and comparisons to history are included here. The historical data are derived from the following sources:
• BP. (2020). Statistical Review of World Energy 2020.
• GISTEMP Team. (2021). GISS Surface Temperature Analysis (GISTEMP), version 4. NASA Goddard Institute
for Space Studies.
• Global Carbon Project. (2020). Carbon budget and trends 2020. [CO2 energy emissions only]
• Gütschow, J.; Günther, A.; Jeffery, L.; Gieseke, R. (2021). The PRIMAP-hist national historical emissions time
series (1850-2018). v2.2. [Non-CO2 greenhouse gas emissions only]
• Houghton, R. A., & Nassikas, A.A. (2017). Global and regional fluxes of carbon from land use and land cover
change 1850–2015. Global Biogeochemical Cycles, 31. [CO2 land use emissions only]
• IEA. (2020). World Energy Outlook 2020.
• IRENA. (2020). Renewable Power Generation Costs in 2019.
• Lazard. (2020). Lazard’s Levelized Cost of Energy Analysis - Version 13.0.
• Morice, C. P., Kennedy, J. J., Rayner, N. A., Winn, J. P., Hogan, E., Killick, R. E., et al. (2020). An updated
assessment of near-surface temperature change from 1850: the HadCRUT5 dataset. Journal of Geophysical
Research: Atmospheres, 126, e2019JD032361.
• NOAA. (2020). Annual Greenhouse Gas Index.
• NOAA Mauna Loa Observatory. (2020). Trends in Atmospheric Carbon Dioxide.
Five historical comparison graphs are also included in the En-ROADS app under Graphs > Model Comparison Historical and are included and disaggregated here:
• Greenhouse Gas Net Emissions History
• Primary Energy Demand of Coal, Oil, and Gas History
• Primary Energy Demand of Wind and Solar History
• Marginal Cost of Solar Electricity History
• Temperature History

1.24.2 Primary Energy Demand History
• Total Primary Energy Demand
• Primary Energy from Coal
• Primary Energy from Oil
• Primary Energy from Natural Gas
• Primary Energy from Nuclear
Global primary energy demand of energy sources for the En-ROADS Baseline compared to IEA historical data. This
is measured in exajoules per year (joules x 1018 /year) for electric and nonelectric sources combined.
Primary energy refers to the total energy from a raw energy source that is converted into consumable energy. For
example, primary coal energy demand refers to the total energy in coal that is mined, processed, and consumed.
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Primary energy is greater than final energy consumption because it accounts for inefficiencies in fuel processing,
thermal conversion, and transmission and distribution (T&D).
Statistical fit

Sources of historical data
• IEA. (2020). World Energy Outlook 2020.
Total Primary Energy Demand

1.24. Model Comparison - Historical
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Primary Energy from Coal

Primary Energy from Oil
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Primary Energy from Natural Gas

Primary Energy from Nuclear

Return to Table of Contents
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1.24.3 Final Energy Consumption History
• Total Final Energy Consumption
• Total Final Energy Consumption - Buildings & Industry
• Total Final Energy Consumption - Transport
• Total Final Energy Consumption - Electric Buildings & Industry
• Total Final Energy Consumption - Electric Transport
Global total final energy consumption of energy sources in exajoules/year (joules x 1018 /year) for electric and nonelectric sources combined in the En-ROADS Baseline compared to historical data.
Final energy consumption is the total energy consumed to meet the demand of all final end uses. For example, how
much electricity a lightbulb uses or how much fuel a truck burns are measures of final energy consumption. It does not
include transmission and distribution (T&D) losses or inefficiencies, which, in contrast, are accounted for in primary
energy demand.
Final energy consumption is divided into two end uses: stationary (buildings and industry) and transport.
Statistical fit

Sources of historical data
• IEA. (2020). World Energy Outlook 2020.
Total Final Energy Consumption
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Total Final Energy Consumption - Buildings & Industry

Total Final Energy Consumption - Transport

1.24. Model Comparison - Historical
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Total Final Energy Consumption - Electric Buildings & Industry

Total Final Energy Consumption - Electric Transport

Return to Table of Contents
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1.24.4 Electricity Generated by Energy Source History
• Electricity Generated by Coal
• Electricity Generated by Oil
• Electricity Generated by Natural Gas
• Electricity Generated by Nuclear
• Electricity Generated by Bioenergy
• Electricity Generated by Hydro
• Electricity Generated by Solar
• Electricity Generated by Wind
• Electricity Generated by Geothermal
• Electricity Generated by Other Renewables
The electricity generated by each energy source in the En-ROADS Baseline compared to historical data.
Statistical fit

Sources of historical data
• IEA. (2020). World Energy Outlook 2020.
Electricity Generated by Coal

1.24. Model Comparison - Historical
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Electricity Generated by Oil

Electricity Generated by Natural Gas
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Electricity Generated by Nuclear

Electricity Generated by Bioenergy

1.24. Model Comparison - Historical
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Electricity Generated by Hydro

Electricity Generated by Solar
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Electricity Generated by Wind

Electricity Generated by Geothermal

1.24. Model Comparison - Historical
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Electricity Generated by Other Renewables

Return to Table of Contents

1.24.5 Marginal Cost of Wind, Solar, and Geothermal Electricity History
• Marginal Cost of Wind
• Marginal Cost of Solar
• Marginal Cost of Geothermal
The marginal cost of electricity production from wind, solar, and geothermal energy in dollars ($US 2017) per kilowatt
hour (kWh) in the En-ROADS Baseline compared to historical data. This is the marginal cost for energy producers to
make electricity from a new solar, wind, or geothermal installation. The cost factors in how much it costs to build new
energy generation facilities (the levelized capital costs) and how much it costs to operate and maintain new facilities
(O&M).
For solar, the En-ROADS Baseline is shown relative to historical data from Lazard, IRENA, and IEA. The IEA &
IRENA curve is calculated from IEA (2020) capital costs per GW from 1990-2019 relative to its 2010 value, and
multiplied by IRENA’s 2010 levelized cost of energy (LCOE) (2020).
For wind, the En-ROADS Baseline is shown relative to historical data from Lazard and IRENA. For geothermal, the
En-ROADS Baseline is shown relative to historical data from Lazard.
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Statistical fit

Sources of historical data
• IEA. (2020). World Energy Outlook 2020.
• IRENA. (2020). Renewable Power Generation Costs in 2019.
• Lazard. (2020). Lazard’s Levelized Cost of Energy Analysis - Version 13.0.
Marginal Cost of Wind

1.24. Model Comparison - Historical
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Marginal Cost of Solar

Marginal Cost of Geothermal

Return to Table of Contents
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1.24.6 Emissions History
• Greenhouse Gas Net Emissions
• CO2 Emissions from Energy
• CO2 Emissions from Fossil Fuels
• CH4 Emissions
• N2O Emissions
• F-Gas Emissions
Global greenhouse gas emissions (GHGs) in the En-ROADS Baseline and historical data, in Gigatons of CO2 or CO2
equivalents per year. CO2 equivalents are used to standardize the effect of all greenhouse gases in terms of CO2 .
The Greenhouse Gas Net Emissions graph measures the total gross greenhouse gas emissions minus the total net
anthropogenic carbon dioxide removal (CDR). Contributions to gross GHGs are from carbon dioxide (CO2 ), nitrous
oxide (N2 O), methane (CH4 ), and the F-gases (PFCs, SF6 and HFCs).
CO2 emissions from energy over 1990-2019 are from Global Carbon Project (2020) data, CO2 emissions from land use
& forestry over 1990-2015 from Houghton and Nassikas (2017) data, and non-CO2 GHG emissions over 1990-2017
are from PRIMAP 2.2 (2021).
Statistical fit

Sources of historical data
• Global Carbon Project. (2020). Carbon budget and trends 2020. [CO2 energy emissions only]
• Houghton, R. A., & Nassikas, A.A. (2017). Global and regional fluxes of carbon from land use and land cover
change 1850–2015. Global Biogeochemical Cycles, 31. [CO2 land use emissions only]
• IEA. (2020). World Energy Outlook 2020.
• Gütschow, J.; Günther, A.; Jeffery, L.; Gieseke, R. (2021). The PRIMAP-hist national historical emissions time
series (1850-2018). v2.2. [Non-CO2 greenhouse gas emissions only]

1.24. Model Comparison - Historical
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Greenhouse Gas Net Emissions

CO2 Emissions from Energy
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CO2 Emissions from Fossil Fuels

CH4 Emissions

1.24. Model Comparison - Historical
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N2 O Emissions

F-Gas Emissions

Return to Table of Contents
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1.24.7 Atmospheric Concentrations History
• CO2 Concentration in the Atmosphere
• CH4 Concentration in the Atmosphere
• N2O Concentration in the Atmosphere
The total concentration of CO2 , CH4 , and N2 O in parts per million (ppm) of CO2 equivalents in the atmosphere in the
En-ROADS Baseline compared to historical data.
Carbon dioxide equivalents (CO2 e) are calculated from the 100-year global warming potential of each gas (IPCC AR5)
for reporting purposes. Note the radiative forcing of each gas is modeled explicitly as a function of its atmospheric
cycle and radiative efficiency.
Statistical fit

Sources of historical data
• NOAA Mauna Loa Observatory. (2020). Trends in Atmospheric Carbon Dioxide.
• GISTEMP Team. (2021). GISS Surface Temperature Analysis (GISTEMP), version 4. NASA Goddard Institute
for Space Studies.
CO2 Concentration in the Atmosphere

1.24. Model Comparison - Historical
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CH4 Concentration in the Atmosphere

N2 O Concentration in the Atmosphere
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1.24.8 Radiative Forcing History
• CO2 Radiative Forcing
• CH4 Radiative Forcing
• N2O Radiative Forcing
• Halocarbon Radiative Forcing
The radiative forcing due to CO2 , CH4 , N2 O, and halocarbons in the atmosphere, in Watts per meter squared (W/m2 ),
in the En-ROADS Baseline compared to historical data. Halocarbons refer to F-gases (PFCs, SF6 , and HFCs) and
Montreal Protocol gases.
Greenhouse gases absorb infrared radiation and re-radiate it back, causing an increase in surface temperature. Radiative forcing measures the difference between energy absorbed by the Earth and energy radiated back into space. When
incoming energy is greater than outgoing energy, RF is positive and the planet will warm.
Statistical fit

Sources of historical data
• NOAA. (2020). Annual Greenhouse Gas Index.
CO2 Radiative Forcing

1.24. Model Comparison - Historical
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CH4 Radiative Forcing

N2 O Radiative Forcing
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Halocarbon Radiative Forcing

Return to Table of Contents

1.24.9 Temperature History
Temperature change from 1850 in the En-ROADS Baseline compared to historical data, in degrees Celsius. NASA
GISS (GISTEMP v5) includes the average and the lower and upper 95% confidence intervals. Met Office Hadley
Centre produced the HADCRUT5 data.
Statistical fit

Sources of historical data
• GISTEMP Team. (2021). GISS Surface Temperature Analysis (GISTEMP), version 4. NASA Goddard Institute
for Space Studies.
• Morice, C. P., Kennedy, J. J., Rayner, N. A., Winn, J. P., Hogan, E., Killick, R. E., et al. (2020). An updated
assessment of near-surface temperature change from 1850: the HadCRUT5 dataset. Journal of Geophysical
Research: Atmospheres, 126, e2019JD032361.

1.24. Model Comparison - Historical
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1.25 En-ROADS Model Version History
1.25.1 March 2022 Release
Interface Changes
• New translations: The core En-ROADS interface is now available in Swahili and Slovenian. Thank you to the
volunteer translators who are helping to bring En-ROADS to thousands of users in their native language.
• Updated sea level rise projection: The “Sea Level Rise” graph reflects the updated sea level rise projection in
En-ROADS, which is now in line with the latest IPCC AR6 report (see “Model Upgrade” notes below). More
details of these changes are available in our blog post.
• Storm surge mapping: The “Sea Level Rise—Flood Risk Map” now includes a new map type called “21st
Century with Storm Surge.” This new mode allows users to show the impact of a localized storm on top of
global sea level rise.
• Added two sliders in the “Sea level rise” group under Assumptions to allow for simulating different ice sheet
melting scenarios for Antarctica and Greenland. The “Sea Level Rise—Flood Risk Map” has been updated to
take these slider values into account.
• Updated the “Population Exposed to Sea Level Rise” graph to use the updated sea level rise projection.
• Renamed the “Methane & Other” slider on the main interface to “Methane & Other Gases.”
• Improved the GDP slider descriptions in the “Economic Growth” advanced view.
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Model Upgrade
• En-ROADS model to version 22.3.0
• Updated the default sea level rise projection in En-ROADS to align with the IPCC Sixth Assessment Report
(AR6). En-ROADS now closely matches the AR6 median estimate. This results in a lower default sea level
rise projection in 2100. Additionally, two new sliders were added (found under Assumptions) to allow users to
explore how the uncertainties of ice sheet melt in Antarctica and Greenland affect global sea level rise.
• Corrected an issue where the model behavior for some impacts (e.g., biodiversity loss) caused the Current
Scenario value to exceed 100% under some extreme scenarios; these are now capped at 100%.

1.25.2 January 2022 Release
Interface Changes
• Added a new slider, “Years to achieve other greenhouse gas targets” in the “Methane & Other Gases” advanced
view, to allow for simulating the 2021 Global Methane Pledge.
• Changed the start year for input sliders to 2022.
• Improved the titles of the miniature graphs for consistency and clarity.
• Adjusted the y-axis range on the “Revenue & Cost from Taxes & Subsidies” graph.
• Reordered the datasets in the CDR graphs to match the order of the sliders in the “Technological Carbon Removal” view.
Model Upgrade
• En-ROADS model to version 22.1.0
• Fixed the behavior of economic assumption sliders (e.g., “Plant development time”, “Plant construction time”,
and “Progress ratio”) so that they do not affect model outputs in past years.

1.25.3 December 2021 Release
Interface Changes
• Russian translation: The core En-ROADS interface is now available in Russian.
• Improved sharing of the “UN Pledges” feature. When opening a shared scenario that includes the “Greenhouse
Gas Net Emissions” graph, the “All Countries Follow NDCs” bar will be shown if the sender had the feature
enabled.
• Corrected the types of power plants in the descriptions for the “CCS effectiveness” sliders (found under Assumptions).

1.25. En-ROADS Model Version History
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Model Upgrade
• En-ROADS model to version 21.12.0

1.25.4 November 2021 Release
Interface Changes
• UN Pledges: Added a “Show UN Pledges (NDCs)” option to the actions menu for the “Greenhouse Gas Net
Emissions” graph. (Click the three vertical dots icon to reveal the menu.) When selected, a red bar will appear
on the graph, indicating the approximate level of emissions in 2030 if all countries were to follow their emissions
reduction pledges.
• Renamed the “Marginal Cost of Renewables—Area” graph to “Marginal Cost of Wind and Solar—Area”. The
graph description now indicates that the data for “Wind & Solar” includes other renewable sources (which
comprise a small percentage of capacity).
• Amended the Electrification slider descriptions to state that the Baseline scenario can contribute to electrification.
• Amended the Electrification and Energy Efficiency slider descriptions to state that the action is phased in over
10 years.
• Improved the descriptions for the “Electric demand response technology” and “Electric carrier” progress ratio
sliders (found under Assumptions).
• Improved color contrast on the “Sea Level Rise—Flood Risk Map.”
• Fixed the Help > En-ROADS User Guide menu item to open the translated version of the User Guide when
available (when German is the selected language, for example).
Model Upgrade
• En-ROADS model to version 21.11.0
• Fixed an issue that caused a mismatch in the Baseline and Current Scenario lines on the “% Electricity Consumption from Qualifying Sources” graph.

1.25.5 October 2021 Release
Interface Changes
• Sea level rise maps: Flood risk maps from Climate Central have been integrated into En-ROADS under Graphs
> Impacts. These maps display the land areas that are at risk of flooding due to sea level rise, as well as the land
that can be saved by actions made in the Current Scenario in En-ROADS. More details of this new feature are
available in our blog post.
• German translation: The En-ROADS User Guide has been translated into German, and the advanced view
help pages in En-ROADS now appear in German when it is the selected language.
• Added carbon budget lines to the “Net Cumulative CO2 Emissions” graph. These lines indicate the level of
accumulated CO2 that is consistent with a 66% chance of hitting either 2°C or 1.5°C. The carbon budget lines
have been updated to be consistent with recently released IPCC AR6 values.
• Removed the “Cumulative CO2 Emissions” graph as it is redundant.
• Fixed the Actions & Outcomes view to display active policy switches (e.g., “Use clean electricity standard”).
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• Corrected the variables displayed in the “Oil Primary Energy Demand—Area” and “Bioenergy Primary Energy
Demand—Area” graphs to match the non-area graphs.
Model Upgrade
• En-ROADS model to version 21.10.0
• Corrected the behavior of the “Renewable Primary Energy Demand” graph when the CDR maximum for BECCS
is set to zero.
• Corrected a bump in the economic damage curve when the “Reduction in GDP at 2°C” and “Maximum reduction
in GDP” settings were the same.
• Fixed an issue where the Social Cost of Carbon value could go negative.
• Fixed an issue that caused a spike in the energy demand graphs when “% Reduction in coal/oil/gas utilization”
is set to 100% and the “stop year” is set earlier than 2100.

1.25.6 September 2021 Release
Interface Changes
• Climate impacts: Five new bar graphs have been added under the Graphs > Impacts menu showing the effects
of climate change:
– Population Exposed to Sea Level Rise
– Probability of Ice-free Arctic Summer
– Decrease in Crop Yield from Temperature
– Species Losing More than 50% of Climatic Range
– Additional Deaths from Extreme Heat
• Graph actions menu: A new contextual menu is available by clicking the “three dots” icon to the right of a
graph title. The menu reveals actions related to the graph:
– Show Description
– View Larger
– View in New Window
– Copy Data to Clipboard
• Updated the range for the “Climate sensitivity” slider to match the new AR6 findings from the IPCC.
• Revised the description for the “Social discount rate” slider.
• Improved handling of scenario links with invalid parameters. When opening a link created with an older version
of En-ROADS, if any parameters are no longer valid, a warning will be displayed showing which sliders are
affected (instead of resetting the entire scenario).

1.25. En-ROADS Model Version History
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Model Upgrade
• En-ROADS model to version 21.9.0
• Fixed the model so that the “HFC phase out start year” slider has an effect only when the “Use detailed settings”
switch is active.

1.25.7 August 2021 Release
Interface Changes
• Japanese translation: Additional graph and slider descriptions have been translated into Japanese.
• To avoid redundancy, air pollution parameters have been consolidated under Assumptions > Air pollution with
a single slider for each fuel type. This does not change model behavior.
• Adjusted the y-axis range on several graphs to better display their plots.
• Matched the y-axis maxima for pairs of graphs that display “Total” and “by Source—Area” information so they
are more easily compared.
• Improved the descriptions for the “Nuclear R&D breakthrough cost reduction” slider and the Bioenergy view.
• Removed a redundant slider for methane leakage from the Natural Gas advanced view. The other slider is found
in the Methane & Other Gases advanced view.
Model Upgrade
• En-ROADS model to version 21.8.0
• Corrected an error in the energy utilization sector which was causing the price of electricity to increase and
preventing renewables from growing as they should in the absence of fossil fuel utilization.
• Corrected an equation which omitted the hydro-generated energy from the “Renewables” plots in the “Final
Energy Consumption” graphs.

1.25.8 July 2021 Release
Interface Changes
• Arabic translation: The core En-ROADS interface is now available in Arabic.
• COVID-19 impacts: Added a set of eight new sliders (under the Assumptions > COVID-19 impacts heading)
for controlling the assumptions about the impacts of the COVID-19 pandemic on greenhouse gas emissions and
other model parameters.
• Removed the “Average Cost of Electricity Production” and “Low-Carbon Average Cost of Production” graphs.
(Utilization in the model no longer depends on average costs, so the marginal cost graphs are more useful.)
• Corrected the y-axis range of the “Land for Growing CO2 -Removal Biomass” and “Land for Farming with CO2
Removal” graphs.
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Model Upgrade
• En-ROADS model to version 21.7.0
• Added structure to model the effects of the COVID-19 pandemic on the global economy, energy demand, and
other indicators.

1.25.9 June 2021 Release
Model Upgrade
New
• Added structure for clean electricity standard and social cost of carbon to the En-ROADS model.
• Transmission and distribution costs for electricity are now included in the variable costs to produce the electricity.
Updated
• En-ROADS model to version 21.6.0
• Note that starting with this release, the model version number is now based on the date of the release (for
example, 21.6 refers to the sixth month of 2021).
Interface Changes
New
• Japanese translation: The core En-ROADS interface is now available in Japanese.
• German translation: Additional graph and slider descriptions have been translated into German.
• Clean electricity standard: Added new features to the “Carbon Pricing and Energy Standards” advanced view:
– Activate the clean electricity standard policy with a switch and adjust the settings of the policy with multiple new input sliders.
– Control the types of energy sources that qualify for the clean electricity standard.
– New graph “% Electricity Consumption from Qualifying Sources” has been added to the Final Energy
Consumption Types group.
• Social cost of carbon: Added new table for the social cost of carbon in the Population & GDP group.
• Added transport electrification sliders to separate out transport based on land (road and rail) from transport based
in air or on water.

1.25. En-ROADS Model Version History
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Updated
• Added a link to view more historical graphs in the Model Comparison—Historical group.
• Added a new button (on the main view and under the Help menu) that links to the web page for registering your
En-ROADS events.
• Added a line to compare the trajectory of HFCs with the Kigali Amendment to the Montreal Protocol on the
“SF6 , PFC, and HFC Emissions” graph.
• Added the “SF6 , PFC, and HFC Emissions” graph to the list of related graphs in the “Methane & Other Gases”
advanced view.
• Added the version number to the lower right corner of the interface.
• Removed “beta” references from the interface.
• Reordered graphs in the Model Comparison—Historical group.
• Improved graph and slider descriptions.

1.25.10 May 2021 Release
Model Upgrade
Updated
• En-ROADS model to version 2.7.39
• Updated data for non-CO2 GHGs through 2018 using PRIMAP 2.2.
Interface Changes
New
• Translation into French: En-ROADS is now available in French.
• Graph replacements: Because of differences in carrier efficiencies, the percent of capital that is electric is not
the same as the percent of final energy for that capital. We have therefore changed the associated graphs from
“Electric Share of Final Energy” to “Electric Share of Capital” for Buildings & Industry and for Transport.
• We have rearranged the ordering of the Simulation > Assumptions sliders to follow the relative order of the
slider groups on the En-ROADS main view.
Updated
• Various small text edits to graph and slider descriptions.
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1.25.11 April 2021 Release
Model Upgrade
Updated
• En-ROADS model to version 2.7.38
• Added model structure for carbon dioxide removal (CDR), carbon capture and storage (CCS), and economic
impact of climate change on GDP.
Interface Changes
New
• Structural upgrades to the user interface: We have updated the underlying architecture of En-ROADS to
allow future feature additions to be added more easily. You will not see any functional differences in the
operation of En-ROADS or in the interface layout of En-ROADS. There are some aesthetic improvements and
multiple changes that make the simulation easier to operate. User experience improvements include:
– The currently selected graph is indicated in the graph selection menu.
– Sliders and menus work better on a wider variety of touchscreen devices (no more touchscreen warnings).
– The interface is more responsive when resizing the browser window.
– The simulation loads faster.
– The Actions & Outcomes view size adapts to its contents.
– Many other subtle additions that will enhance the usability of the simulation.
• New Assumptions slider for social discount rate: We have added a new input slider, “Social discount rate,” under the Assumptions > Economic impact of climate change heading. The effect of changes to the social discount
rate are displayed in a new graph, “Global GDP Loss” and in the Actions & Outcomes table as “Discounted
Cumulative Damage through 2100.”
• New Assumptions slider for fossil fuel CCS leak rate: We have added a new input slider, “Fossil fuel CCS
leak rate,” under the Assumptions > Carbon capture & storage (CCS) effectiveness heading. This slider allows
the user to test non-zero leak rates for fossil fuel CCS.
• New graphs added to the simulation:
– In the Removals and Land Use group:
* Annual Volume of Captured CO2
* Cumulative Storage of CO2
– GDP-related graphs relocated to the Population & GDP group:
* Reduction in GDP vs Temperature
* Reduction in GDP from Climate Impacts
– New GDP-related graphs also under the Population & GDP group:
* GDP per Capita Growth Rate
* Global GDP Loss (which also shows the discounted value of economic damage)
Read more in our blog post about climate impacts on GDP.

1.25. En-ROADS Model Version History
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• New historical comparison graphs: There is a new graph menu group, Model Comparison—Historical. These
graphs compare historical data to En-ROADS simulation output from 1990-2020.
– Temperature History
– Marginal Cost of Solar Electricity History
– Primary Energy Demand of Coal, Oil, and Gas History
– Primary Energy Demand of Wind and Solar History
– Greenhouse Gas Net Emissions History
• Added Spanish translations of graph and slider descriptions.

1.25.12 March 2021 Release
Model Upgrade
Updated
• En-ROADS model to version 2.7.37
• Added model structure for economic impact of climate change on GDP.
Interface Changes
Fixed
• Improved the colors on the “Renewables Capacity — Area” graph to make the plots easier to distinguish.
• Changed the Simulation > Assumptions > Climate sensitivity > “Sea level rise from ice sheet melting” slider
label to “Additional sea level rise from ice sheet melt” and edited its associated description text for greater
clarity.
New
• Translation into Italian: En-ROADS is now available in Italian.
• New slider for Economic impact of climate change: A new slider type with two input “handles” has been
added to the Assumptions menu: Economic impact of climate change. The two handles control “Reduction in
GDP at 2ºC from climate impacts” and “Maximum reduction in GDP.”
• Two new “Climate impact on GDP” related graphs have been added under the Impacts header:
– Reduction in GDP vs Temperature
– Reduction in GDP from Climate Impacts
• Read more in our blog post about the economic impact of climate change in En-ROADS.
• Added an Assumptions slider for the progress ratio of electrifying transport, buildings, and industry under
Simulation > Assumptions > Progress ratio > Electric carrier.
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1.25.13 February 2021 Release
Model Upgrade
Updated
• En-ROADS model to version 2.7.36
• Updated temperature change data and reference years using new temperature data update in HADCRUT5 dataset
from December 2020.
• Modified En-ROADS to use baseline data from C-ROADS that is fed into the En-ROADS data model for initialization.
• Updated profitability effects to avoid getting too large with extremes that were leading to drastic and unrealistic
swings that could be seen in capacity, utilization, and pricing.
• PRIMAP 2.1 data (2019) of historic GHG emissions were used to update initial fractions of each non-CO2 GHG
emissions from agriculture, waste, extracted fuel supply, demand capital, and non-CO2 GHG emissions from
energy use) and to improve calibration.
• Improved and simplified CH4 concentration calibration to avoid unnecessarily introducing more uncertainty in
response to CH4 concentration effects on uptake and to include updated PRIMAP data.
Fixed
• Resolved unexpected bioenergy demand spikes that had appeared in the previous release for some scenarios.
Interface Changes
New
• Four new translations: New translations added for simplified Chinese, traditional Chinese, German, and Bulgarian. More languages on the way in March!
• New graphs: New graphs added related to enhanced mineralization and other carbon removal approaches:
– Land for Growing CO2 -Removal Biomass
– Land for Farming with CO2 Removal
– Bulk Material for Mineralization
For more details about the carbon removal approaches displayed in these new graphs see this related blog post.
• Added new assumptions specific to enhanced mineralization (found in Assumptions > Mineralization settings).
• Relocated the Language menu to the first menu position and included a globe icon as an indicator for the menu.
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Fixed
• Changed terminology from “mid-19th century” to 1850.
• Adjusted some graph and slider labels for better fit in translations.

1.25.14 January 2021 Release
Interface Changes
New
• Translation into Turkish: We have a new translation into Turkish this release. Check it out under the Language
menu.
• New graph: Added a new graph, “% Electricity Consumption from Low-Carbon Sources”. Find it under “Final
Energy Consumption Types” under the Graphs menu.
• Corrected all references to Purchasing Power Parity to $US 2017. Other various text edits.

1.25.15 December 2020 Release
Read more details about the update.
Watch a video overview of the details of the update.
Model Upgrade
New
• Updated Baseline: Several model adjustments related to renewable energy sources, pre-industrial temperature
benchmarking, and modeling of non-greenhouse gas forcings have lowered the baseline temperature in 2100 to
3.6°C/6.5°F.
• Renewables are now disaggregated and explicitly modeled for solar, wind, geothermal, and other renewables.
• We also account for the historical subsidies for renewables and the “soft costs” associated with each renewable
type. These soft costs have declined as experience was gained.
• The temperature change reported is now relative to the 19th century.
• Initial heat is now calculated from historic temperature change in 1990, taken from temperature anomaly relative
to 19th century from GISS (2020) and Hadley (2020) and adjusted to be relative to 18th century mean.
• Other forcings taken from Meinshausen (2011) to reflect those relative to 18th century. Natural forcings easier
to subtract to obtain anthropogenic forcings for Equivalent CO2 concentration.
• Initial CO2 , CH4 , and N2 O updated to reflect actual data from GISS instead of C-ROADS 1990 values.
• Decrease in extraction overheating sensitivity and profitability effects on retirement rates of supply sources to
dampen rapid changes in bioenergy demand.
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Updated
• En-ROADS model to version 2.7.35c
Interface Changes
New
• New default graphs: Changed the default graphs from “Global Sources of Primary Energy” and “Temperature
Change” to “Global Sources of Primary Energy — Area” and “Greenhouse Gas Net Emissions”.
• Added several graphs related to renewable energy:
– “Low Carbon Average Cost of Electricity Production by Source”,
– “Low Carbon Marginal Cost of Electricity Production by Source”, and
– “Renewables Capacity — Area”.
• Changed the phrase “Business as usual” and “BAU” to “Baseline” across the interface, graphs, legends and
descriptions.
• Renamed “New Technology” Energy Supply to “New Zero Carbon” Energy Supply throughout En-ROADS
interface.
• Changed the population input slider to display “billion people in 2100” instead of the -1 to +1 index range.
• Expanded the inputs for Economic Growth from a single input to now include “Long-term economic growth”,
“Near-term economic growth” and a “Transition time” for the “Near-term economic growth” to converge on the
“Long-term economic growth” rate.
Fixed
• Changed the start year for input sliders to 2021.
• The ranges for Tax/Subsidy sliders have been updated.
• Some graph descriptions have been edited for clarity.
• Adjusted the Y-axis maximum on some graphs to display the data better over different input configurations.

1.25.16 October 2020 Release
Model Upgrade
Updated
• En-ROADS model to version 2.7.29b
• Corrected the “New Tech” plot in the “Marginal Cost of Electricity Production” graph when the “New Technology” advanced sliders are adjusted.

1.25. En-ROADS Model Version History
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Interface Changes
Fixed
• Added a short description at the top of the Assumptions panel to clarify how the sliders behave relative to the
“Current” and “Business as Usual” scenarios.
• Fixed descriptions of transport electrification sliders to remove mention of ships and airplanes.

1.25.17 September 2020 Release
In addition to the details listed below, we’ve made a video highlighting the important new features.
Check it out: September 2020 Release Video
Interface Changes
New
• Spanish: En-ROADS is now available in Spanish! We’re working to bring En-ROADS to even more languages
too.
• Air Pollution graphs: There are two new graphs in the “Graphs > Impacts” menu showing Air Pollution (PM2.5
Emissions) from the energy sector. Additionally, sliders were added in the “Assumptions” panel to allow for
adjusting the emission factor assumptions.
Model Upgrade
Updated
• En-ROADS model to version 2.7.29
Control Slider Related Changes
Updated
• Changed the population slider units to be on -1 to 1 indexed scale with “status quo” equal to zero.
• Fixed the units of the Carbon Price slider to read “$/ton CO2 ” instead of “$/ton”.
Other Interface Changes
Updated
• Fixed the Kaya view to show “Carbon Intensity of Final Energy” instead of “Carbon Intensity of Primary
Energy”.
• Fixed the menu bar to make it easier to select sub-menu items on iPad.
• Fixed tooltips on iPad so that they disappear automatically.
• Fixed alignment of slider handles on iPad.
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• Fixed full screen layout on iPad so that the menu bar is not obscured by the Safari-provided controls.
• Fixed the large graph window to display in the current language (instead of defaulting to English).
• Fixed the x-axis labels on Kaya graphs to not overlap on large screens.
• Fixed graphs to not show tooltips for years outside the displayed range.
• Removed calibration graphs (these will be replaced by improved graphs in an upcoming release).

1.25.18 August 2020 Release
Interface Changes
New
• Portuguese: En-ROADS is now available in Portuguese! Localization to more languages is in progress, and we
hope to come to your native language soon.
• Initial iPad Support: You can now run En-ROADS on your iPad (in Safari or your preferred browser)! In this
release, the user experience is better on iPad models released in the last 3 years. In upcoming releases, we will
be working to improve performance and refine the user experience across all iPad models.
Updated
• Improved performance in a number of areas, so sliders should feel smoother and more responsive (and further
improvements are in the works).
• When sharing a scenario, the user’s preference for Metric vs U.S. Units is captured and remembered in the URL.
Control Slider Related Changes
Fixed
• Updated the “Carbon Price” slider description to include bioenergy in the list of impacts.
• Removed accidental mention of deforestation in the “Other greenhouse gases start year” slider description under
“Methane & Other Gases”.

1.25.19 July 2020 Release
Graphs
Fixed
• Corrected the y-axis of the “Marginal Cost of Electricity Production” graph to adjust dynamically to keep graph
lines in view.
• Corrected the “Renewables Primary Energy Demand” graph to reflect hydro in addition to renewables.

1.25. En-ROADS Model Version History
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Control Slider Related Changes
Fixed
• Improved descriptions for the “Year to stop building new infrastructure” sliders for coal, oil, and natural gas.
Other Interface Changes
Updated
• Improved email sharing of scenarios by showing a preview of the message to be sent, and allowing for a custom
note to be included with the shared scenario.
• Changed the welcome screen to direct feedback and questions to support.climateinteractive.org.
• Changed the “General FAQs” link under the Help menu to direct to the Knowledge Base on the support site.

1.25.20 May 2020 Release
Model Upgrade
Updated
• En-ROADS model to version 2.7.19
• Add email sharing of your current scenario to “Share Scenario” menu button.
• Update GDP with 2018 World Bank data.
Fixed
• Minor edits to description texts

1.25.21 April 2020 Release
Model Upgrade
Updated
• En-ROADS model to version 2.7.14
• Added link to “Uses for En-ROADS” under the Help menu
• Add menu control for “Reset Policies” sliders and “Reset Assumptions” sliders under “Simulation” menu;
changed wording of “Reset” to “Reset Policies & Assumptions.”
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Graphs
• When switching from Metric Units to U.S. Units, the “Land for Carbon Dioxide Removal” graph switches from
“Million hectares” to “Million acres”.
Fixed
• Improved location of icons in the top toolbar to help avoid accidental clicks on the “Reset Policies & Assumptions” icon (formerly, “Reset sliders” tool tip).
• Correcting Large graph feature so graphs are sized correctly in the remote window.
• Edits to description texts for “Coal carbon capture & storage (CCS) (tax/subsidy)” slider, “Gas carbon capture
& storage (CCS) (tax/subsidy)” slider and the overall description for Nuclear in the advanced views.

1.25.22 March 2020 Release
Along with the details listed below, we’ve made a cool video highlighting the important feature additions and changes
to model behavior.
Check it out: March 2020 Release Video
Model Upgrade
Updated
• En-ROADS model to version 2.7.11
• Updated the equation for the Energy Intensity of New Capital to better respond to price effects
• BAU improvement rate in emission intensity and Annual improvement rate of emission intensity for F-gases
were adjusted to reflect SSP2 baseline trajectories
• The settings for CH4 and N2 O emissions from agriculture and waste have also been slightly updated
Graphs
Fixed
• Add “Hydro” data to “Average Cost of Electricity Production” graph and correct the name of “Renew/Hydro”
to Renewables”
• Corrected several missing Related Graphs in some advanced views
• Corrected the variable in “Marginal Cost of Renewables” graph
• Corrected typo in descriptions for N2 O and CH4 graphs (Megatons was corrected to 1x106 )
• The y-axis label in graph “CO2 Emissions” was corrected to Gigatons CO2 /year

1.25. En-ROADS Model Version History
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Updated
• Edited the description for “CH4 Emissions” graph and corrected the plotted variable to display anthropogenic
CH4 emissions
• Edited “Storage Costs” graph description for clarity
• Edited the description for “Cumulative CO2 Emissions” graph
• Changed the graph name from “Fuel Production Cost” to “Fuel Production Cost by Source” to make it consistent
with the titles of the other graphs in the Financial category that are broken out by energy source
• Added “Greenhouse Gas Net Emissions by Gas—Area” to related graphs for Deforestation
Control Slider Related Changes
Fixed
• Updated New Tech slider description to match what the slider settings do
• Added back a missing description for slider, “Coal CCS R&D breakthrough cost reduction”
• Edit description for slider, “% Reduction in Coal Utilization”
Updated
• Edit slider names referring to final carbon price, removing the word “target” so it is now:
– Final carbon price (previously, Final Carbon price final target)
– Year to start achieving final carbon price (previously, Year to start achieving final carbon price target)
– Years to achieve final carbon price (previously, Years to achieve final carbon price target)
• Added back assumptions sliders for “Methane emissions from biological activity”, “Effect of temperature on
methane emissions from permafrost and clathrates”, and “Temperature threshold for permafrost and clathrates”
Other Interface Changes
New
• You can create a large copy of any of the graphs to use on additional screens or monitors. The graph outputs in
the copies remain connected to changes in the control input sliders. These graphs are accessed under the View
menu, as “Large Left Graph and “Large Right graph”. You may select multiple copies of left or right graphs.
Coming Soon
• Localization to many languages is in process! We hope to come to your native language soon!
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TWO

INDICES AND TABLES

• genindex
• modindex
• search
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